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Global Data Synchronization Network
Overview
The Global Data Synchronization Network (GDSN) was created as an industry endorsed
initiative to overcome product data inaccuracies and increase efficiency among trading
partners and their supply chains. GDSN is a web based, interconnected network of
interoperable data pools and a global registry.

With GDSN you can capture and exchange product information in a secure environment
conforming to global standards. By using GDSN you can assure that data exchanged
between trading partners is accurate and compliant with universally supported standards.

GDSN consists of supplier and retailer trading partner, data pools that hold and process
trading partner data and the GS1 Global Registry. A directory that helps locate data sources
and keep relationships between trading partners in sync.

With GDSN, trading partners always have the latest information in their systems. Any
changes made to one company's database are automatically and immediately provided to
all of the other companies who do business with them.

With accurate and updated data, a supplier and a customer can do business in a smoother,
quicker, and less expensive way.

Terminology Differences in the GDSN Edition
There are some differences between GDSN and MDM software editions. The default edition
is MDM.

GDSN Name MDM Name

Repository Repository

Synchronize Synchronize

Terminology Differences in GDSN
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GDSN Name MDM Name

Trading Partner Backend System

Record Record

Datapool Integration Hub

GDSN Specific Configuration Properties
The following configuration properties are specific to GDSN:

Property Configuration
Outline

Value Description

Plugins Advanced GDSN List of Plugins
installed. For
example, GDSN.

Software Edition
>Application
Usage Profile

Basic GDSN Defines whether
the application is
used for data
synchronization
(GDSN) or master
data management
(MDM)

Software Edition >
Common Menus
Configuration

Advanced config/security/
allmenu.xml

The configuration
file location for
common menus
(navigation bar)

Function > Enable
Market Place

Advanced True Marketplace
related menus is
visible.

Function >
Company Profile

Advanced True Company Profile
menu is visible.

GDSN Specific Configuration Properties



ibi™ MDM Add-on for Global Data Synchronization User Guide

9 | Global Data Synchronization Network Overview

Property Configuration
Outline

Value Description

Integration Setup -
External >
Connector
Rulebase

Advanced standard/rulebase/
rbconnectorprotocol
derivation_gdsn.xml

The rulebase to
identify the
protocol (for
example, CIM2CIM,
1WorldSync)

Integration Setup -
External > Sync
Status Rulebase

Advanced standard/rulebase/
rbsyncstatus
updatederivation.xml

Sync status
derivation, used to
identify operation
and suboperation.

Integration Setup -
External >
Synchronization
Format Specific
Attributes File

Advanced rbformatattributes_
gdsn.xml

The name of the
rulebase file used
to customize
format specific
attributes on the
Synchronization
profile View and
Edit page.

Rule Base->Send
Message Screen
Rulebase File

Advanced rbsendmessage_gdsn.xml The name of the
rulebase file used
to customize
record attribute
display on the
SendMessage
page

Integration Setup -
External -->Work
Item Description
Rulebase File

Advanced rbworkitemdescription_
gdsn.xml

The name of the
rulebase file to
customize work
item messages

GDSN Specific Roles
You can access the Roles page by clicking Administration > Roles. It displays all available
Roles and descriptions.

In addition to the standard MDM roles, the following roles are GDSN specific and visible
only in the GDSN edition of MDM:
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Channel Manager

Is a user responsible for business activity in a particular sales channel. Typically
responsible for relationships with Datapools or a set of buying organizations.

Sales Rep

Is a member of the supplier sales organization who acts upon current items in the Inbox
that pertains to their area. Sales Rep is not created for the MDM edition. If it existed
already, it is not deleted during migration.
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GDSN Predefined Components
For GDSN, a set of predefined components such as maps, rulebases, workflows, and
templates are shipped with the application.

All these components are located in relevant folders under $MQ_
HOME/plugins/gdsn/<version>/common/standard

For details, see GDSN Predefined Components.
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GDSNMenu Options and Pages
GDSN-specific options (that are not displayed in the standard MDM version) in the menus
and pages in ibi MDM.

l Datapool Profiles in the Administration Menu

l All Company Profiles Page

l My Company Profiles Page

l Datapool Profiles Page

l Trading Partner Profiles Page

l View Repository Page

l Message Acknowledgments

l Inbox UI

l Event Log Search

l Customizing Workitem Descriptions

GDSN Specific Menu Items
Some menu items are available specific to GDSN version of MDM.

Datapool Profiles in the Administration Menu
The Administration menu includes a Datapool Profiles option that is specific to the GDSN
version of MDM.

A Datapool Profile defines an electronic sales channel, datapool, or hub - where backend
systems can exchange goods. Datapool Profiles and credentials are used to establish new
datapools and manage the datapool activities.

A Datapool Profile correlates to a workflow associated with the datapool and you can
subscribe or unsubscribe a Datapool as required. Datapool credentials are provided
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automatically; however, you can define additional credentials. For more details, see
Datapool Profiles Page.

GDSN Specific Pages
Some pages are available specific to the GDSN version of ibi MDM. Also, a few menu names
are also changed. For example, the Master Data menu name is changed to Item Data in the
GDSN version.

All Company Profiles Page
The All Company Profiles page is accessed by clicking Administration > All Company
Profiles > Create and is used by super users to create enterprises.

You can specify the Name, and Internal Name for the enterprise, the Industry Vertical,
and the Type. The Type list contains Supplier, Retailer, and Datapool as options.
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My Company Profiles Page
You can access the Company Profile page by clicking Administration > My Company
Profile and displays the profile of the company that you have logged into.

This page consists of contact information and credentials for your company. The purpose
of company credentials is to enable your organization to communicate with a datapool.

The following information is GDSN-specific:
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Extended Credentials
Each credential can be supplemented with additional information known as extended
credentials.

To create extended credentials, click the Credentials link in the Datapool section of the
Company Profile page.

This data is used for authentication when communicating with the datapool. To define an
extended credential, first define a basic credential.

Extended credentials are unique across enterprises. These constraints are implemented
using predefined seed data and cannot be changed using the UI.
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The following constraints apply to datapools:

l Basic credentials must be unique in an organization.

l Only one GLN per enterprise

To create extended credentials, click Administration > MyCompany Profile > and then
click Credentials in the Datapool section. Click Create.

Enter the required details and click Save.
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Datapool
The page displays the datapool the company is subscribed to. A "Not subscribed to any
Datapool" message indicates that no datapool subscriptions have been made for the
company.

You can subscribe to a datapool by clicking Datapool Profiles (see Datapool Profiles
Screen). This opens the Datapool Profiles page that displays all the datapools supported by
ibi MDM. Click Subscribe to subscribe to that datapool. Only datapools that the company is
subscribed to are available for participation by the backend system.

Datapool Profiles Page
This is the first page you see when you click Administration > Datapool Profiles. It
displays all datapools that you can subscribe to and are supported by ibi MDM.

Use this page for the following activities:

l Modify Datapool Profiles To modify a datapool profile, click Modify in the Actions
column. The Datapool Profiles - Synchronization Formats page is displayed. On this
page you can:

o Modify supported synchronization formats. ibi MDM supports formats
specific to datapools, and default formats can be set for each datapool. If
custom formats are required, they can be created using synchronization
formats.
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o Create Credentials. A Datapool credential uniquely identifies a datapool or
backend system within a datapool. This establishes message origination and
destination for that backend system. For example, a supplier wants to do
business with a backend system through a datapool such as 1WorldSync. the
datapool provides User IDs and Passwords or credentials to both the supplier
and backend system, and identifies itself to both using its own password and
credentials.

l Subscribe or Unsubscribe to Datapools  Click the Subscribe or Unsubscibe button in
the Actions column.

l Filter Datapools By default, all datapools are displayed. They can be sorted based
on subscription from the View drop-down list.

There are two forms of Datapool profiles. The most common form is when a company
wants to communicate with a Datapool. In this case, the only data elements visible are:

l Subscribe to this Datapool.

l Define any integration URL, if applicable.

l Define credentials. Here, the credentials of the Datapool are defined (and not the
company as company credentials are defined in the Company Profile).

l Some preexisting credentials are displayed as read only. These credentials are global
and can only be modified by a super user.

A supplier organization Datapool Profile consists of:

l Documents for communication - such as Item Add, or Item Publish.

l A document format - such as EANUCC, XML, 1WorldSync, and so on.

Trading Partner Profiles Page
You can access the page by clicking Administration > Trading Partner Profiles, and then
clicking Create.

Using this page, you can create a new trading partner profile for your company. Two ways
to exchange data with a trading partner are:

l Publish data to the Datapool from where the data gets synchronized with the trading
partner.
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l Deliver the data to the trading partner directly through FTP or email.

The Datapool option in this page is GDSN-specific. Select to subscribe.

When you view a trading partner profile, if not subscribed to any datapools, you see the
message "Not subscribed to any datapools" in the Datapool Participation section.

View Repository Page
The View Repository page displays the content of a selected repository and you can access
by clicking Item Data > Repositories. The following information is GDSN-specific:

Selected Predefined Classification Schemes

Classification schemes that are provided with the application by default are referred to as
predefined classification schemes and are listed here. The schemes listed here are those
selected at the time of creating the repository.
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You can click the Classification Scheme name to view details; this displays the
Classification Scheme Modify page. On this page, click Show Usage to view the
Classification Scheme Usage.

Message Acknowledgments
When a message is sent from a Supplier to a Retailer, the retailer can send an
acknowledgment for the message using the Send Response utility.

Enabling Message Acknowledgments
By default, message acknowledgments are not enabled. You need to enable permissions
for a user to send a response.

Procedure
1. Go to Administration > Resource Security.

2. From the list, select Resource Type as Repository and Resources as <name of
Repository>. Click Show Permissions. The Manage Resource Security for
Repositories page is displayed.

3. On the Manage Resource Security for Repositories page, select Resource Type as
Record and click the Add Grantee button.
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4. You can assign a user or a role as grantee. Select the grantee and click OK.

5. A list of permissions is displayed in the Permission Name column.  Click Allow
against Allow action - Send Response permission and click Save.

Sending Message Acknowledgments
You can send a record as a response.

Restriction: The Send Response option is not available in the 3.0.3 release.

Procedure
1. Click Browse and Search.
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2. From the Repository Name list, select the name of the repository.

3. Click View All.
A list of records is displayed.

4. Click the record ID of a record.

5. On the View Record page, select Send Response.

6. On the Send Response page, you can set the following options:

l Action: Select Review, Received, Synchronised, or Rejected.

l Retailer Credential: Select the retailer credential from the drop-down list.

7. Click Submit.

8. On the View Record page, click Ok.
The acknowledgment is sent to the Supplier.

Inbox UI
You can access the page by clicking Inbox on the main menu. The Inbox shows a list of
tasks or work items assigned or delegated based on the configured business process rule.
The Inbox content is influenced by your Role. Work items are classified as notification (no
action required) or action (action required).

You can search for items (by clicking the Search button) based on criteria such as:

l State: View work items by state - All, Canceled, Closed, Open, or Timed out work
items.

l Type: Filter work items by type - All, Action Items, Notifications.

l Document Type: Filter work items by Document Type such as All, Mass Update,
Record Content Notification, Record Edit, or Synchronization.
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l Action: Filter work items by the Action performed, such as Data Change, Data
Correction, MassUpdate, Record Add, Record Add Notification, and Synchronization.

l Trading Partner: Filter work items by trading partner.

l Event ID: Filter work items by entering the exact event ID.

l From Date/To Date: Filter work items created within a certain date range. It is not
mandatory to specify both the start and end dates of a period that you are tracking.
You can specify either of them.

l Repository: Filter work items by repository. It displays the list of repositories to
which you have access (at least LIST access). Work items can be searched for a
specific repository. To remove a filter the search needs to be cleared.

l Record Attribute: Filter work items based on the values of Record Attributes. For
example, to search SecurityID - 00049822430355; you can either enter the complete
SecurityID or enter a partial value (00049822) to get the work item.

l Sort by Record Attribute: Sort work items based on record attribute. Select the
record attribute from the drop-down list. If you want to sort the list in the
descending order of the record attribute, select the Descending check box.

l Datapool: Filter work items by datapool.

l Show Action Items First: If selected, displays action items followed by notifications.

l Search/Sort: Enter your search criteria and click Search/Sort to generate a list of
work items matching your criteria. If you want to change the search criteria, click
Clear to reset the criteria.

l Clear: Clears the search

l Configure: To configure the columns displayed in the table.

Event Log Search
You can access this page by clicking Event Log in the main menu and then click the
Search option.
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The Event Log page shows a list of all events in the system. You can click Search to search
for events based on criteria such as:

l Event Status

l Event Type

l Event ID

l User ID

l Operation

l Trading Partner

l Datapool

l Event Start Date

l Event End Date

l Record ID

l RecordID Ext.

GDSN Customization
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Customizing Workitem Descriptions

You can include hyperlinks to objects such as Repositories, Catalogs, Trading Partners, and
so on in your workitem description. You can include only one hyperlink per object in a
message by including the relevant token in the description.

For details on tokens that can be used, refer to chapter Customizing Workitem Descriptions
in the ibi MDM Customization Guide .

GDSN Specific Information

For the $Catalog$ token that is used to create a hyperlink with a catalog, the name of the
catalog appears in place of the token, hyperlinked to the latest version of the catalog.
However, there are some exceptions applicable to the GDSN version:

l Catalogue Item Notification (CIN) message notifications received by retailers

l Catalog Item Confirmation (CIC) received by suppliers, which were not sent to the
retailers using the catalog
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Synchronization
The application has some GDSN-specific information in synchronization profiles and
formats in ibi MDM.

l Synchronization Profiles

l GDSN Specific Synchronization Formats

l Using Custom Synchronization Formats

l Updating Synchronization Status
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Synchronization Profiles
Synchronization Profiles provide a way of extracting information from repositories.

As part of the Synchronization Profile definition, you can choose records and attributes to
be extracted, record versions, whether to apply transformation rules, and where to send
the extracted data. Synchronization Profiles once created can be reused to extract data.

You can view the Synchronization Profile by clicking Item Data > Synchronization
Profiles. Details for all available synchronization profiles can be viewed here, with related
information in specific columns such as the Repository, Synchronization Format, Delivery,
and so on.

Creating Synchronization Profiles

Procedure
1. Click Item Data > Synchronization Profiles.

2. Then click Create on the Synchronization Profiles page.

Note: When creating a Synchronization Profile, some options are GDSN-
specific.
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Delivery
In the Delivery section of the Create Synchronization Profile page, you can select the
entity to deliver records to. The following entities are GDSN-specific:

l Datapool

Datapool is the central repository. When you select Datapool, and click Synchronize,
the system sends the data as a message to the Datapool. The message is sent in the
XML format and the system requires an acknowledgment from the Datapool. You
need to provide the name of the Datapool, the output map, and the delivery
mechanism.

l Trading Partner on Datapool

When you select this option, and click Synchronize, the message is sent to only
those trading partners who are subscribed to the Datapool. The trading partner
should have a valid GLN account with the Datapool. You can select multiple trading
partners in this option. You need to specify both the Datapool and trading partners
subscribed to the Datapool. You also need to specify the Output Map format and the
delivery mechanism.

Format Specific Attributes
Format Specific Attributes vary based on where you want to deliver the records.

If Datapool is selected in the Delivery group, the following is displayed:

l Operation: You can select from the following operations:
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o Add: Adds the record to the Datapool.

o Data Correction: If there is a discrepancy in the published record, you can
select Data Correction to rectify the record. In this case, the record reverts to its
original state.

o Cancel: If you cancel a record, you cannot publish or reinstate the same record
within 24 to 48 months of cancellation.

o Discontinue: If you discontinue a record, you cannot publish the same record
within 24 to 48 months.

o Reinstate: Using reinstate, you can republish a discontinued record.

l Classification Scheme: The classification scheme listed in the Company Profile are
displayed here.

l Supplier Credential: The credentials listed in the Company Profile are displayed
here.

l Deliver Synchronization Profile: Select Yes if you wish to deliver the
synchronization profile to the backend system.

l Generate Output file?: Select the option to generate output file.

If Trading Partner on Datapool is selected in the Delivery group, the following additional
fields are displayed:

l Operation: You can select from the following operations:

o Add: Adds the record to the Datapool.

o Data Correction: If there is a discrepancy in the published record, you can
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select Data Correction to rectify the record. In this case, the record reverts to its
original state.

o Publish: Publishes the record to the selected backend systems.

l Classification Scheme: The classification scheme listed in the Company Profile are
displayed here.

l Supplier Credential: The credentials listed in the Company Profile are displayed
here.

l Deliver Synchronization Profile: Select Yes if you wish to deliver the
synchronization profile to the backend system.

l Generate Output file?: Select the option to generate output file.
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Synchronization Formats
The application currently provides a set of predefined synchronization formats.

You can access this page by clicking Item Data > Synchronization Formats.

GDSN Specific Synchronization Formats
Synchronization formats define the attributes and structure of the data required by the
consumers of that data (external systems or datapools).

Output maps define mappings of repository attributes to synchronization formats. When a
repository is synchronized, the synchronization format provides the structure for the
output information.

For GDSN, many predefined synchronization formats are supplied which are not modified.
The following are GDSN-specific synchronization formats:

l 1SYNC

l EAN.UCC

l EAN.UCC.SUBSCRIPTION

l GS1

l SA2

l TIBCO

l XML
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Using Custom Synchronization Formats

Procedure
1. Copy the EAN.UCC synchronization format to create the <CustomUCC> format.

l Select the EAN.UCC format check box and click the Copy button.

l Provide a name and description on the Synchronization Format copy page.

2. Create output map <CustomOutputMap>.

l Go to Item Data->Repositories

l Select a repository, go to the Output Maps tab, click Create.

3. Change the rulebase to select <CustomOutputMap>. For more information on
creating a rulebase, refer the ibi MDM Studio Rulebase Designer Guide. The modified
rulebase section will look like the following:

<assign> <var>OUTPUTFORMAT</var>   <const
type="string">CustomOutputMap</const>   </assign>

Note: If you are not using the default EAN.UCC format, you need to make
changes to the rulebase to publish an output map created for a custom
synchronization format.

Navigate to <MQ_

COMMONDIR>/standard/rulebase/rbsyncstatusupdatederivation.xml to add
the name of custom output map instead of "EAN.UCC" as in the following
section:

<assign>
<var>OUTPUTFORMAT</var>
<const type="string">EAN.UCC</const>
</assign>

There may be several similar replacements required.

4. Perform Update sync status. For more information on updating synchronization
status, see Updating Synchronization Status.
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Synchronization Status
Synchronization Status (synch status) is the status of the record synchronized with
Datapool.

You can update the synch status using Updating Synchronization Status.

Updating Synchronization Status
Records are always synchronized with Datapools.

The synchronization state (sync status) of a record can be incorrect in the following cases:

l Datapool failed to respond.

l Message(s) failed in Datapool(s) and there was no response from messages.

l Response was received but response format was not comprehensive and the
processing failed.

l Record was synchronized outside the application. For instance, you migrated from
MDM to another GDSN system.

When the sync status is incorrect, it affects the next message generated by the application
and synchronization is not possible. To resolve this issue, the sync status needs to be
updated.

You can update the sync status of the record.

Procedure
1. Click Browse and Search.

A list of Repositories are displayed.

2. In the Repository list, select the repository.

3. Click View All.
A list of records is displayed.

4. Click the record whose synch status you want to update.
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5. On the View Record page, click Update Sync Status.

6. On the Update Synch Status page, select the values for the following fields:

l Datapool

l Trading Partner

l Operation

l Sub-Operation

7. Click Save to update sync status.

Note: An out-of-the-box installation assumes that EAN.UCC is associated
with the repository. If this format is not associated, the operation fails. To
correct this, either associate the synchronization format or use another
synchronization format in the rulebase
rbsyncstatusupatederivation.xml.
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Updating Synchronization Status Using Utility
By using the updateSyncStatus utility, you can correct the synchronization status of a
record in ibi MDM. Run the utility if the synchronization status of records in 1WorldSync
and ibi MDM is different. The updateSyncStatus.bat and updateSyncStatus.sh utility files
are available in $MQ_HOME\bin.

Procedure
1. Navigate to $MQ_HOME/bin/migration and create a file named

updatesyncoperations.txt and enter the details of a operation (in the following
format) that you want to perform:

productkeyid,operation,suboperation
SQL command to retrieve PRODUCTKEYID

For example,

10004,ADD,NEW

SQL command to retrieve PRODUCTKEYID

select * from MCT_34819 to get CPRODUCTKEYID of 00005555565578 =>
10013

2. Navigate to $MQ_HOME\bin.

3. Run the following command:

updateSyncStatus.bat -cid SYNC1_CATLOG_ID -of Catalog outputmap name -mid
organization_ID for the market place

l CATLOG_ID: selects ID from catalog where NAME=SYNC1

l Catalogoutputmap name (outputformat): 1SYNC

l organization_ID for the market place: selects ID from ORGANIZATION
where NAME=1SYNCTEST

For example,

updateSyncStatus.bat -cid 34819 -of 1SYNC -mid 32699
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The optional tradingPartner attribute is required if you want to publish records to a
trading partner.

Result
The synchronization status is updated. You can synchronize the records.
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Validations and Codelists
MDM has validations present for mandatory and optional attributes in 1WorldSync and
MDM’s implementation of the 1WorldSync codelists.

l 1WorldSync Validations Overview

l MDM Validation for 1WorldSync Mandatory Attributes

l MDM Validation for 1WorldSync Optional Attributes

l MDM Implementation of 1WorldSync Codelist

1WorldSync Validations Overview
While communicating to subscribers, 1WorldSync specifies certain rules to be followed to
ensure that the data received is correct.

1WorldSync performs validation on different types of messages received and processed.

Supported 1WorldSync Validations
MDM supports the following 1WorldSync validations:

l When messages of type Item Load (Item Add, Item Modify Item Link, or Item Unlink
transaction) are received

l When messages of type Item Publish are received

For more details, refer MDM Validation for 1WorldSync Mandatory Attributes and
MDM Validation for 1WorldSync Optional Attributes for validations implemented in
MDM for mandatory and optional attributes by 1WorldSync for Item Load messages.
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MDM Validation for 1WorldSync Mandatory Attributes
The following table lists validations implemented in MDM for mandatory attributes specified by 1WorldSync for Item Load messages (Item Add, Item Modify).

In the table below:

l IM Attribute is the attribute name in 1WorldSync.

l 1WorldSync Error Code is the error displayed by 1WorldSync in case of validation problems.

l MDM Repository Attribute is corresponding name of the 1WorldSync attribute in the MDM Repository.

l 1WorldSync Catalog Output Map Attribute is the name of an attribute created by MDM using the 1WorldSync Catalog Output Map.

IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Global Trade Item Number 1021, 1024, 1025 GTIN GTIN

GTIN Name 1040 GTIN_NAME GTIN_NAME

Product Type 1080 UOM PRODUCT_TYPE

Target Market 1160 TARGET_MARKET_ID TARGET_MARKET

Language No error code available DESCLANGUAGE LANGUAGECODE

Information Provider (GLN) 1011 1061, 1064, 1062, 4020 INFORMATION_PROVIDER_ID INFORMATION_PROVIDER

Brand Name 1050 ITEM_BRAND_NAME BRAND_NAME

Item Classification Code (GPC) 1070 ADDITIONAL_CLASS_CAT_CODE ALT_ITEM_CLASSN_CODE

Qty of Next Level Item(s) 1130 UNITS_PER_CONTAINER PACK

Ordering Unit Indicator 1140 ORDERING_UNIT ORDERING_UNIT_INDICATOR

Start Availability Date 1150 START_AVAILABILITY_DATE START_AVAILABILITY_DATE

Height 1100 PRODUCTHEIGHT HEIGHT

Height UOM 1101 HEIGHT_UOM HEIGHT_UOM

Validation for 1WorldSync mandatory attributes
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IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Width 1120 PRODUCTWIDTH WIDTH

Width UOM 1121 WIDTH_UOM WIDTH_UOM

Depth 1110 PRODUCTDEPTH DEPTH

Depth UOM 1111 DEPTH_UOM DEPTH_UOM

MDM Validation for 1WorldSync Optional Attributes
The following table lists validations implemented in MDM for optional and dependent attributes specified by 1WorldSync for Item Load messages (Item Add, Item Modify).

IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Alternate Item Classification Scheme 1071, 1077, 3085 ADDITIONAL_CLASS_CAT_CODE ALT_ITEM_CLASSN_CODE

CLASSIFICATIONSCHEME CLASSIFICATION_SCHEME

Flash Point Temperature UOM 1548, 1549 FLASHPOINT_TEMP1 FLASHPOINT_TEMP

FLASHPOINT_UNITS1 FLASHPOINT_TEMP_UOM

Product Strength UOM 1686, 1687 PROD_STRENGTH PROD_STRENGTH

PROD_STRENGTH_UOM PROD_STRENGTH_UOM

Product Strength Basis UOM 1689, 1690 PROD_STRENGTH_BASIS PROD_STRENGTH_BASIS

PROD_STRENGTH_BASIS_UOM PROD_STRENGTH_BASIS_UOM

Diameter UOM 1780, 1781 DIAMETER DIAMETER

DIAMETER_UOM DIAMETER_UOM

Drained Weight UOM 1783, 1784 DRAINED_WEIGHT DRAINED_WEIGHT

DRAINED_WEIGHT_UOM DRAINED_WEIGHT_UOM

Validation for 1WorldSync Optional Attributes
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IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Gross Weight UOM 1786, 1787 GROSSWEIGHT GROSS_WEIGHT

GROSS_WEIGHT_UOM GROSS_WEIGHT_UOM

Net Weight UOM 1790, 1789 NETWEIGHT NET_WEIGHT

NET_WEIGHT_UOM NET_WEIGHT_UOM

Volume UOM 1801, 1802 VOLUME VOLUME

VOLUME_UOM VOLUME_UOM

Width UOM 1804, 1805 PRODUCTWIDTH WIDTH

WIDTH_UOM WIDTH_UOM

Max Stacking Weight UOM (formerly Max Admissible Stacking Weight UOM) 1901, 1902 STACKING_WEIGHT_MAX MAX_ADM_STACKING_WEIGHT

MAX_ADM_STACKING_WEIGHT_UOM MAX_ADM_STACKING_WEIGHT_UOM

Storage/Handling Temp UOM 6228 STORAGE_HANDL_TEMP_MIN_UOM STORAGE_HANDL_TEMP_MIN_UOM

STORAGE_HANDL_TEMP_MAX_UOM STORAGE_HANDL_TEMP_MAX_UOM

Alternate Item Number 2002 ALTERNATE_ID ALTERNATE_ITEM_ID

ALTERNATE_ITEMID_MNT_AGENCY ALTERNATE_ITEMID_MNT_AGENCY

Fat Content Basis of Measure UOM 2084, 2085 FAT_CONTENT_BASIS_MEASURE FAT_CONTENT_BASISOF_MEASURE

FAT_CONTENT_BASIS_UOM FAT_CONTENT_BASIS_UOM

Net Content (Metric) UOM (formerly Size (Metric) UOM) 4043 BASE_UNIT BASE_UNIT_INDICATOR

NET_CONTENT_PRIMARY SIZE_METRIC

NET_CONTENT_UOM SIZE_METRIC_UOM

Ordering Unit Indicator 3013, 3014, 3015 ORDERING_UNIT ORDERING_UNIT_INDICATOR

Gross Weight GROSSWEIGHT GROSS_WEIGHT

Gross Weight UOM GROSS_WEIGHT_UOM GROSS_WEIGHT_UOM
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IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Product Strength Basis 3040, 3041 PROD_STRENGTH PROD_STRENGTH

PROD_STRENGTH_BASIS PROD_STRENGTH_BASIS

Ordering Unit Indicator 3051 ORDER_INCREMENT ORDER_QUANTITY_MULTIPLE

ORDERING_UNIT ORDERING_UNIT_INDICATOR

Ordering Unit Indicator 3053 MAXIMUMORDER MAX_ORDER_QUANTITY

ORDERING_UNIT ORDERING_UNIT_INDICATOR

Ordering Unit Indicator 3055 MINIMUMORDER MIN_ORDER_QUANTITY

ORDERING_UNIT ORDERING_UNIT_INDICATOR

Fat Content Basis of Measure 3100, 3101 FAT_PERCENT_IN_DRY_MATTER FAT_CONTENT

FAT_CONTENT_BASIS_MEASURE FAT_CONTENT_BASISOF_MEASURE

Non GTIN Pallet Height UOM 3138 PACKAGEDHEIGHT NONGTIN_PL_HEIGHT

NONGTIN_PL_HEIGHT_UOM NONGTIN_PL_HEIGHT_UOM

Non GTIN Pallet Gross Weight UOM 3140 NONGTIN_PL_GR_WEIGHT NONGTIN_PL_GR_WEIGHT

NONGTIN_PL_GR_WEIGHT_UOM NONGTIN_PL_GR_WEIGHT_UOM

Global Item Classification Code 1072 ADDITIONAL_CLASS_CAT_CODE ALT_ITEM_CLASSN_CODE

EAN/UCC Code 4008 EAN_UCC_CODE EAN_UCC_CODE

EAN/UCC Type EAN_UCC_TYPE EAN_UCC_TYPE

EAN/UCC Code 4002, 4003 EAN_UCC_CODE EAN_UCC_CODE

Qty of Next Level Item(s) 212, 4005, 106, 4023 UNITS_PER_CONTAINER PACK

Brand Name 1051 ITEM_BRAND_NAME BRAND_NAME

Sub Brand 1740 ITEM_SUB_BRAND_NAME SUB_BRAND

Ordering Unit Indicator 655, 111 ORDERING_UNIT ORDERING_UNIT_INDICATOR
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IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Special Item Code 4022 SPECIAL_ITEM_CODE SPECIAL_ITEM_CODE

Depth UOM 3120 DEPTH_UOM DEPTH_UOM

Width UOM WIDTH_UOM WIDTH_UOM

Height UOM HEIGHT_UOM HEIGHT_UOM

Diameter UOM DIAMETER_UOM DIAMETER_UOM

Peg Hole Number 6216 PEG_HORIZONTAL PEG_HORIZONTAL

PEG_VERTICAL PEG_VERTICAL

PEG_HOLE_NUMBER PEG_HOLE_NUMBER

Peg Horizontal UOM 6216 PEG_HORIZONTAL PEG_HORIZONTAL

PEG_HORIZONTAL_UOM PEG_HORIZONTAL_UOM

Peg Vertical UOM 6216 PEG_VERTICAL PEG_VERTICAL

PEG_VERTICAL_UOM PEG_VERTICAL_UOM

Net Content (Metric (formerly Size Imperial UOM)) 6216 NET_CONTENT_SECONDARY, SIZE_IMPERIAL,

NET_CONTENT_SECONDARY_UOM SIZE_IMPERIAL_UOM

Net Content (Metric (formerly Size (Metric)) 6216 NET_CONTENT_PRIMARY SIZE_METRIC

NET_CONTENT_UOM SIZE_METRIC_UOM

List Price Basis UOM 6216 LIST_PRICE_BASIS_PER_UNIT LIST_PRICE_BASISPERUNIT

LIST_PRICE_BASISPERUNIT_UOM LIST_PRICE_BASISPERUNIT_UOM

Product Size Code Maintenance Agency 6216 SIZE_CODE PROD_SIZE_CODE

SIZE_CODE_LIST_AGENCY PROD_SIZE_CODE_MAINT_AGENCY

Storage/Handling Temp UOM 6216 STORAGE_HANDLING_TEMP_MAX, STORAGE_HANDL_TEMP_MAX,

STORAGE_HANDL_TEMP_MAX_UOM STORAGE_HANDL_TEMP_MAX_UOM
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IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Storage/Handling Temp UOM 6216 STORAGE_HANDLING_TEMP_MIN STORAGE_HANDL_TEMP_MIN

STORAGE_HANDL_TEMP_MIN_UOM STORAGE_HANDL_TEMP_MIN_UOM

Color 6216 COLOR COLOR

Color Code Maintenance Agency COLOR_CODE_AGENCY COLOR_CODE_MNT_AGENCY

Organic Claim Agency 6216 ORGANIC_CLAIM_AGENCY ORGANIC_CLAIM_AGENCY

Organic Claim Item Code ORGANIC_CODE ORGANIC

Material Code Agency 6216 MATERIAL_CODE_AGENCY MATERIAL_CODE_AGENCY

Packaging Material Code PKG_MATERIAL_CODE PACKAGING_M ATERIAL_CODE

Packaging Material Composition PACKAGING_WEIGHT PACKAGING_WEIGHT

Packaging Material Composition UOM PACKAGING_WEIGHT_UOM PACKAGING_WEIGHT_UOM

List Price Basis Per Unit   List Price Basis Per Unit UOM 6216 LIST_PRICE LIST_PRICE

PRICEUOMCODE PRICEUOMCODE

LIST_PRICE_BASISPERUNIT_UOM LIST_PRICE_BASISPERUNIT_UOM

LIST_PRICE_BASISPER_UNIT LIST_PRICE_BASISPERUNIT

LIST_PRICE_DATE_START LIST_PRICE_DATE_START

Tax (Rate) 6216 TAX_RATE TAX_RATE

Type Code   Tax (Rate) TAX_TYPE_CODE TAX_TYPE

Type Description Tax (Rate) TAX_TYPE_DESC TAX_TYPE_DESC

Type Agency TAX_AGENCY_CODE TAX_AGENCY_CODE
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IM Attribute 1WorldSync Error Code Repository Attribute Sync Profile Attribute

Tax Amount 6216 TAX_AMOUNT TAX_AMOUNT

Tax Amount Currency CURRENCY_CODE CURRENCY_CODE

Tax (Amount) Type Description TAX_AMT_TAX_TYPE_DESC TAX_AMT_TAX_TYPE_DESC

Tax (Amount) Type Agency TAX_AMT_TAX_AGENCY_CODE TAX_AMT_TAX_AGENCY_CODE

Tax (Amount) Type Code TAX_AMT_TAX_TYPE_CODE TAX_AMT_TAX_TYPE_CODE

Alternate Item Classification Code 1078 UDEXCODE GLOBAL_CLASSIFICATION_CODE

Information Provider (GLN) VE-0180_VE-0190 INFORMATION_PROVIDER_ID INFORMATION_PROVIDER

Brand Owner (formerly Owning Organization) VE-0270 BRAND_OWNER_ID OWNING_ORGANIZATION_GLN

Variant VE-0320 VARIANT VARIANT

Functional Name VE-0330 PRODUCTNAME PROD_NAME

MDM Implementation of 1WorldSync Codelist
Certain 1WorldSync attributes accept only values from a code list.

The following table lists the MDM implementation of the 1WorldSync code list. For a given attribute in the ‘IM Attribute’ column, the Repository Attribute column lists how the code list is implemented on
the attribute.

IM Attribute Repository Attribute MDM Datasource Name

Language DESCLANGUAGE LANGUAGE_CODES

Storage/Handling Temp UOM STORAGE_HANDL_TEMP_MAX_UOM  STORAGE_HANDL_TEMP_MIN_
UOM

TEMP_CODES

Barcode Type BAR_CODE_TYPE BAR_CODE_TYPES

Alternate Item Classification Scheme CLASSIFICATIONSCHEME CLASSIFICATION_SCHEMES

Country of Origin COUNTRYOFORIGINCODE COUNTRY

MDM Implementation of 1WorldSync Codelist
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IM Attribute Repository Attribute MDM Datasource Name

Country of Assembly TRADE_ITEM_COUNTRY_ASSEMBLY COUNTRY

Variable Trade Item Type VARIABLE_TRADE_ITEM_TYPE No Datasource.   Code values are of type enumeration, contained in the rulebase XML
file.

Depth UOM DEPTH_UOM LINEARUNIT

Width UOM WIDTH_UOM

Height UOM HEIGHT_UOM

Diameter UOM DIAMETER_UOM

Peg Horizontal UOM PEG_HORIZONTAL_UOM

Peg Vertical UOM PEG_VERTICAL_UOM

Size Dimension UOM SIZE_DIMENSION_UOM

Non GTIN Pallet Height UOM NONGTIN_PL_HEIGHT_UOM

Gross Weight UOM GROSS_WEIGHT_UOM WEIGHTUNIT

Net Weight UOM NET_WEIGHT_UOM

Drained Weight UOM DRAINED_WEIGHT_UOM

Material Weight UOM MATERIAL_WEIGHT_UOM

Packaging Material Composition UOM PACKAGING_WEIGHT_UOM

Non GTIN Pallet Gross Weight UOM NONGTIN_PL_GR_WEIGHT_UOM

Max Stacking Weight UOM MAX_ADM_STACKING_WEIGHT_UOM
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IM Attribute Repository Attribute MDM Datasource Name

Fat Content UOM, FAT_CONTENT_UOM PRICE_MATERIAL_UOM_CODES

Fat Content Basis of Measure UOM FAT_CONTENT_BASIS_UOM

Product Strength UOM PROD_STRENGTH_UOM

Product Strength Basis UOM PROD_STRENGTH_BASIS_UOM

List Price Basis Basis UOM LIST_PRICE_BASISPERUNIT_UOM

Suggested Retail Price Basis UOM RECOMMEND_PRICE_PERUNIT_UOM

Selling UOM SELLING_UOM SELLING_ORDERING_UOM_CODES

Ordering UOM ORDERING_UOM

Price Comparison Measurement UOM PRICE_COMP_UOM

Order Sizing Factor UOM ORDER_SIZING_FACTOR_UOM

Generic Ingredient Strength Units of Measure GENERIC_INGREDIENT_STR_UOM GENERIC_INGR_STRGTH_UOM_CODES

Product Size Code Maintenance Agency SIZE_CODE_LIST_AGENCY PRODUCT_SIZE_CODE_AGENCIES

Organic Claim Agency ORGANIC_CLAIM_AGENCY ORGANIC_CLAIM_AGENCY_CODES

Size System SIZE_SYSTEM SIZE_SYSTEM_CODES

Size Group SIZE_GROUP SIZE_GROUP_CODES

Size Type SIZE_TYPE SIZE_TYPE_CODES

Composition Width UOM TRADE_ITEM_COMPOS_WIDTH_UOM No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.

Packaging Material Code PKG_MATERIAL_CODE PACKAGING_MATERIAL_CODES

Material Code Agency MATERIAL_CODE_AGENCY PACKAGING_MATERIAL_CODES
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IM Attribute Repository Attribute MDM Datasource Name

Returnable Package Deposit Amount Currency RETURN_PKG_DEPOSIT_AMT_CURR CURRENCY_CODES

Tax Amount Currency CURRENCY_CODE

List Price Currency PRICEUOMCODE

Retail Price On Trade Item Currency RETAIL_PRICE_ON_ITEM_CURR

Security Tag Location SECURITY_TAG_LOCATION SECURITY_TAG_LOCATIONS

Security Tag Type SECURITY_TAG_TYPE SECURITY_TAG_TYPES

Packaging Marked Expiration Date Type PKG_MARKED_EXPIRE_DATE_TYPE No Datasource.   Code values is of type enumeration, contained in the rulebase xml
file.

Package Marks Diet Allergen PACKAGE_MARKS_DIET_ALLERGEN PACKAGE_MARKS_DIET_ALLERGEN

Package Marks Free From PACKAGE_MARKS_FREE_FROM PACKAGE_MARKS_FREE_FROM_LIST

Package Marks Ethical PACKAGE_MARKS_ETHICAL No Datasource.   Code values are of type enumeration, contained in the rulebase xml
file.

Pallet Code PALLET_TYPE_CODE PALLET_TYPE_CODES

Pallet Terms and Conditions PALLET_HANDL_ONEWAY_REUSE PALLET_TERMS_AND_CONDITIONS

Import Classification Type IMPORT_CLASS_TYPE IMPORT_CLASSIFICATION_TYPES

Min Storage Humidity UOM STORAGE_HUMIDITY_MIN_UOM No Datasource.   Code values are of type enumeration, contained in the rulebase xml
file.

Max Storage Humidity UOM STORAGE_HUMIDITY_MAX_UOM
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IM Attribute Repository Attribute MDM Datasource Name

Min DC Delivery Temp UOM DELIVERY_DC_TEMP_UOM TEMP_CODES

Max DC Delivery Temp UOM

Min Market Delivery Temp UOM DELIVERY_MARKET_TEMP_UOM

Max Market Delivery Temp UOM

Flash Point Temperature UOM FLASHPOINT_UNITS1

Storage/Handling Temp UOM STORAGE_HANDL_TEMP_MAX_UOM

STORAGE_HANDL_TEMP_MIN_UOM

Compliance Regulation Code CLASS_COMPLIANCE_REG_CODE CLASS_COMPLIANCE_REG_CODES

Goods Pick Up Lead Time UOM GOODS_PICKUP_LEAD_TIME_UOM No Datasource.   Code values are of type enumeration, contained in the rulebase xml
file.

Price Comparison Content Type PRICE_COMP_CONTENT_TYPE PRICECOMPARISIONCONTENTTYPES

Price By Measure Type PRICE_BY_MEASURE_TYPE PRICE_BY_MEASURE_TYPES

Target Consumer Gender TARGET_CONSUMER_GENDER No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.

Season Parameter SEASON_PARAMETER SEASON_PARAMETERS

Dangerous Goods Regulation Code HAZMAT_CLASSCODE1 DANGER_GOODS_REGULATION_CODES

Color Code Maintenance Agency COLOR_CODE_AGENCY COLOR_CODE_AGENCIES_1SYNC

Handling Instruction Code SPECIAL_HANDLING_CODE SPECIAL_HANDLING_CODES

Lead Time UOM LEADTIMEUOMCODE No Datasource.

Organic Trade Item Code ORGANIC_CODE ORGANIC_TRADE_ITEM_CODES

Packaging Terms And Condition PACKAGING_TERMS_CONDITIONS PKG_TERMS_CONDITIONS_CODES

Packaging Type Code PACKAGING_TYPE_CODE PACKAGING_TYPE_CODES

Primary Delivery Methods PRIMARY_DELIVERY_METHOD PRIMARY_DELIVERY_METHOD_CODES
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IM Attribute Repository Attribute MDM Datasource Name

GTIN Variation Registry GTIN_VARIATION_REGISTRY No Datasource.   Code values are of type enumeration, contained in the rulebase xml
file.

Base Unit Indicator BASE_UNIT No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.
Consumer Unit Indicator CONSUMER_UNIT

Dangerous Goods Indicator DANGEROUS_GOODS

Dispatch Unit Indicator DESPATCH_UNIT

Has Batch Number HAS_BATCH_NUMBER

Invoice Unit Indicator INVOICE_UNIT

Is Trade Item Reorderable IS_REORDERABLE

Is Size Based Pricing IS_TRADEITEM_SIZE_BASED_PRIC

Net Content Declared NET_CONTENT_DEC_INDICATED

Ordering Unit Indicator ORDERING_UNIT

Packaging Marked Returnable PACKAGE_MARKED_RETURNABLE

Pricing On Product PRICE_ON_PACKAGE

Pricing Item Indicator PRICING_ITEM

Is Private PRIVATE

Private Label PRIVATE_LABEL

Product Marked Recyclable PROD_MARKED_RECYCLABLE

Right of Return for Non-Sold Trade Item RIGHT_RETURN_NONSOLD_TRADE

Variable Weight Trade Item VARIABLE_UNIT

Product Marked with Ingredients WITH_INGREDIENTS

Is Barcode Symbology Derivable ISBARCODEDERIVABLE

EANUCC Type EAN_UCC_TYPE EANUCCTYPE
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IM Attribute Repository Attribute MDM Datasource Name

Volume UOM VOLUME_UOM VOLUMEUNIT

Net Content UOM NET_CONTENT_UOM NETCONTENTUNIT

Product Type UOM UNITDESCRIPTOR

Target Market TARGET_MARKET_ID COUNTRY

Alternate Item Identification Maintenance Agency ALTERNATE_ITEMID_MNT_AGENCY ALTERNATEITEMIDMAINTAINAGENCY

Special Item Code SPECIAL_ITEM_CODE SPECIALITEMCODE

Is Ingredient Irradiated INGREDIENT_IRRADIATED No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.
Is Raw Material Irradiated RAW_MATERIAL_IRRADIATED

Is Trade Item Irradiated IRRADIATED

Genetically Modified GENETICALLY_MODIFIED

Is Product Subject To A Manufacturer Take Back Program TAKE_BACK_PROGRAM

Is Hazardous Component Brokendown Easily For Recycling HAZARDOUS_COMP_REMOVABLE

Is Product Disassembly By Recycling Facility Completed Using Standard
Tools

DESIGN_FOR_EASY_DISASSMBLY

Product RoHS Compliance Code IS_RIGID_PLASTIC_PACKAGING
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IM Attribute Repository Attribute MDM Datasource Name

Does Product Contain SCCPs CONTAINS_SCCP No Datasource.

Code values are of type enumeration, contained in the rulebase xml file.
Does Product Contain PVC CONTAINS_PVC

Can Product Be Easily Upgraded Or Maintained By Consumer IS_UPGRADEABLE_OR_MAINTAIN

Is TradeItem Auto Powered Down Enabled When Shipped To Customer POWER_DOWN_ENABLED

Is Product Chemical Not Intended For Human Consumption CHEMICAL_FOR_HUMAN_CONSUME

Is Product A Pesticide CONTAINS_PESTICIDE

Is Product Aerosol CONTAINS_PROPELLANT

Is Product Considered Universal Waste IS_UNIVERSAL_WASTE

Is Product RPPC Compliant In TargetMarket IS_ROHS_COMPLIANT

Is TradeItem Packed Irregularly IS_ITEM_PACKED_IRREGULARLY

Has Display Ready Packaging HAS_DISPLAY_READY_PKG
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Maintaining Validations and Codelists
Validations and codelists can be maintained by updating codelists and adding validations.

Updating Codelists
Certain attribute values are from a list of values only, called the code list.

Values not in the list are not accepted. In MDM, code lists are implemented using a
rulebase and in most cases, populated using a predefined datasource created for the
tibcocim/tadmin (enterprise/user) super user.

If datapool has released an update to the code list, first establish whether the code list was
implemented using a datasource or enumeration.

Updating a Codelist Implemented Using Datasource

Procedure
1. Find the name of the datasource used for the code list. See MDM Implementation of

1WordSync Codelist.

2. Create a CSV file of the updated codelist.

3. Log in to the super user enterprise.

4. Click Item Data > Data Sources.

5. Modify the datasource as obtained in step 1.

6. Expand the Attribute tab on the Data Source Modify page. Ensure the attribute name
in the datasource definition on the UI and the CSV file’s (created in step 2) header are
the same.

7. Provide the CSV file created in step 2 to the File to Upload field.

8. Click Save and Upload.
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9. Check the Event Log to ensure the event completes successfully, and all rows of the
CSV file import successfully.

Updating a Codelist Implemented Using
Enumeration

Procedure
1. Edit the $MQ_COMMON_DIR/standard/rulebase/_XX_mastercatalog_validation.xml

file. Here XX is the name of datapool for which you want to update the code list.

2. Find the name of the MDM attribute for which the enumeration is defined.

3. In the validation file, search for the constraint with the attribute name. For example,
to update the code list for MATERIAL_WEIGHT_UOM for 1WorldSync, update the
following constraint in the _1sync_mastercatalog_validation.xml validation file.

<constraint>
<name>Drop down for MATERIAL_WEIGHT_UOM</name>
<description>Valid value list for MATERIAL_WEIGHT_UOM</description>
<usefor>

<var>MATERIAL_WEIGHT_UOM</var>
</usefor>
<action>

<select novalue="default">
<enum header="yes" col="2">
<const type="string">UOM<sep/>Description</const>
<const type="string">ON<sep/>Ounces per square yard</const>
<const type="string">GM<sep/>Grams per square meter</const>
</enum>
</select>

</action>
</constraint>

For more details on rulebase constraints, refer to the ibi MDM Studio Rulebase Designer
guide.
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Updating Validations
You can add a new validation by adding a new constraint with the new attribute name in
the relevant rulebase.

Example

New Attribute to Add

Consider a new mandatory attribute Target Region to be added to 1WorldSync. And
presume that TARGET_REGION is the attribute name added to both the 1WorldSync
catalog format and TIBCO format.

Files to Add Constraint to

The constraint should be added to both the files listed below, both in the $MQ_COMMON_
DIR/standard/rulebase folder.

_1sync_mastercatalog_catalogvalidation.xml_1sync_catalogvalidation.xml

Constraint to Add

<constraint>
<name>Mandatory validation for TARGET_REGION </name>
<description>This attribute is mandatory.</description>
<usefor>

<var> TARGET_REGION </var>
</usefor>
<action>

<check>
<explanation>This attribute is mandatory.</explanation>

<defined>
<var />

</defined>
</check>

</action>
</constraint>
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Message Choreography
Message choreography, in this context, refers to the information flow between a specific
datapool (1WorldSync for instance) and the GS1 Global Registry.

GDSN supports trading partners to use the (certified) datapool of their choice to
synchronize data with other trading partners in GDSN. GDSN certified datapools help in
continued synchronization of data, and registered trading partners are assured of updated
and accurate data in their systems.

MDMMessage Choreography for 1WorldSync
MDM currently supports 1WorldSync datapool. For MDM to work with this datapool, some
specific changes are required.

Validation takes place in 2 instances: on the record ID when entering the records and when
synchronizing data. GS1 and 1WorldSync specify certain rules which must be followed to
ensure that the quality of data received is correct.
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1WorldSync Attribute Mapping

Note: In the following table, "Sync Profile Attribute" refers to the 1WorldSync Output map attribute. Sync is the abbreviated form of Synchronization.

The following table lists how attributes in 1WorldSync map to attributes in MDM.

1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Global Trade Item Number String GTIN GTIN os:envelope/catalogueRequest/
document/item/gtin

Information Provider String INFORMATION_PROVIDER INFORMATION_PROVIDER_
ID

os:envelope/catalogueRequest/
document/item/information
ProviderGLN

Effective Date Date TDC_PRODUCTION_DATE TDC_PRODUCTION_DATE os:envelope/catalogueRequest/
document/item/effectiveDate

GTIN Name String GTIN_NAME GTIN_NAME os:envelope/catalogueRequest/
document/item/globalAttributes/
gtinName

NA String LANGUAGECODE DESCLANGUAGE "This is a common attribute, which is being used in many elements of the
1WorldSync message, for example:

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productDescription
[@lang]; os:envelope/catalogue
Request/document/item/
targetMarketAttributes/
shortDescription[@lang]"

Product Type String PRODUCT_TYPE UOM os:envelope/catalogueRequest/
document/item/globalAttributes/
productType

Brand Name String BRAND_NAME ITEM_BRAND_NAME os:envelope/catalogueRequest/
document/item/globalAttributes/
brandName

Brand Owner GLN String OWNING_ORGANIZATION_
GLN

BRAND_OWNER_ID os:envelope/catalogueRequest/
document/item/globalAttributes/
brandOwnerGLN

1WorldSync Attribute Mapping
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Net Content Decimal SIZE_METRIC NET_CONTENT_PRIMARY os:envelope/catalogueRequest/
document/item/globalAttributes/
netContent[@uom]

Net Content UOM String SIZE_METRIC_UOM NET_CONTENT_UOM os:envelope/catalogueRequest/
document/item/globalAttributes/
netContent[@uom]

Alternate Item Classification Code String GLOBAL_CLASSIFICATION_
CODE

UDEXCODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateClassification/
code

Packaging Type String PACKAGING_TYPE PACKAGING_TYPE_CODE os:envelope/catalogueRequest/
document/item/globalAttributes/
packagingInformation/packaging
TypeCode

Qty of Next Level Item(s) String PACK UNITS_PER_CONTAINER os:envelope/catalogueRequest/
document/item/globalAttributes/
totalQuantityOfNextLower
TradeItem

Packaging Information Height Float PACKAGING_HEIGHT PACKAGING_HEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
height

Packaging Information Height UOM Varchar PACKAGING_HEIGHT_
UOM

PACKAGING_HEIGHT_
UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
height

Packaging Information Depth Float PACKAGING_DEPTH PACKAGING_DEPTH os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
depth

Packaging Information Depth UOM Varchar PACKAGING_DEPTH_UOM PACKAGING_DEPTH_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
depth

Packaging Information Width Float PACKAGING_WIDTH PACKAGING_WIDTH os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
width
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Packaging Information Width UOM Varchar PACKAGING_WIDTH_UOM PACKAGING_WIDTH_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
width

Inner Pack String INNER_PACK UNITS_PER_INNER_
CONTAINER

os:envelope/catalogueRequest/
document/item/globalAttributes/
innerPack

Product Form String PRODUCT_FORM FORM_DESCRIPTION os:envelope/catalogueRequest/
document/item/globalAttributes/
ProductForm

Base Unit Indicator Boolean BASE_UNIT_INDICATOR BASE_UNIT os:envelope/catalogueRequest/
document/item/globalAttributes/
isBaseUnit

Consumer Unit Indicator Boolean IS_TRADE_ITEM_
CONSUMER_UNIT

CONSUMER_UNIT os:envelope/catalogueRequest/
document/item/globalAttributes/
isConsumerUnit

Variable Weight Trade Item Boolean VARIABLE_WEIGHT_TRADE_
ITEM

VARIABLE_UNIT os:envelope/catalogueRequest/
document/item/globalAttributes/
isVariableWeightItem

Num of Complete Layers Cont in Item/GTIN Pallet Hi Integer HI HI os:envelope/catalogueRequest/
document/item/globalAttributes/hi

Num of Items in a Complete Layer/GTIN Pallet Ti Integer TI TI os:envelope/catalogueRequest/
document/item/globalAttributes/ti

Storage/Handling Temp Max Decimal STORAGE_HANDL_TEMP_MAX STORAGE_HANDLING_TEMP_
MAX

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/maximumTemperature

Storage/Handling Temp UOM String STORAGE_HANDL_TEMP_
MAX_UOM

STORAGE_HANDL_TEMP_
MAX_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/storageHandling
TempMax[@uom]

Storage/Handling Temp Min Decimal STORAGE_HANDL_TEMP_MIN STORAGE_HANDLING_TEMP_
MIN

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/minimumTemperature

Storage/Handling Temp UOM String STORAGE_HANDL_TEMP_ STORAGE_HANDL_TEMP_ os:envelope/catalogueRequest/
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

MIN_UOM MIN_UOM document/item/targetMarket
Attributes/storageHandling
TempMin[@uom]

Own Label/Private Label Boolean OWN_LABEL_PRIVATE_
LABEL

PRIVATE_LABEL os:envelope/catalogueRequest/
document/item/globalAttributes/
brandDistributionTradeItemType

Number of Items/Pallet Integer NUM_OF_ITEMS_PER_
PALLET

PALLET_QUANTITY os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/numberOfItems
PerPallet

Target Market String TARGET_MARKET TARGET_MARKET_ID os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetMarket

Target Market Description String TARGET_MARKET_DESC TARGET_MARKET_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetMarketName

NA String MARKET_GROUP MARKET_GROUP os:envelope/catalogueRequest/
document/publication/
marketGroup

EANUCC Code String EAN_UCC_CODE EAN_UCC_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gs1TradeItem
IdentificationKey/value

EANUCC Type String EAN_UCC_TYPE EAN_UCC_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gs1TradeItem
IdentificationKey/code

Manufacturer GLN String MANUFACTURER_GLN null os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/manufacturer/gln

Sub Brand String SUB_BRAND ITEM_SUB_BRAND_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/subBrand

Functional Name String PROD_NAME PRODUCTNAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/functionalName[@lang]
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Variant String VARIANT VARIANT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='variants']/row/attr
QualMany[@name='variant]/
value

Country of Origin String COUNTRY_OF_ORIGIN COUNTRYOFORIGINCODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/countryOfOrigin/
countryCode

Is Private Boolean IS_PRIVATE PRIVATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isPrivate

Primary Delivery Method String PRIMARY_DELIVERY_
METHOD

PRIMARY_DELIVERY_
METHOD

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/distributionDetails/
distributionMethodCode

Coupon Family Code Integer COUPON_FAMILY_CODE COUPON_FAMILY_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/couponFamilyCode

Has Batch Number Boolean HAS_BATCH_NUMBER HAS_BATCH_NUMBER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hasBatchNumber

Net Content Declared Boolean NET_CONTENT_DEC_
INDICATED

NET_CONTENT_DEC_
INDICATED

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isNetContentDeclaration

Product Strength Decimal PROD_STRENGTH PROD_STRENGTH os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
ingredientStrength/ingredient
Strength

Product Strength UOM String PROD_STRENGTH_UOM PROD_STRENGTH_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productStrength[@uom]

Product Strength Basis Decimal PROD_STRENGTH_BASIS PROD_STRENGTH_BASIS os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
ingredientStrength/ingredient
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

StrengthBasis

Product Strength Basis UOM String PROD_STRENGTH_BASIS_
UOM

PROD_STRENGTH_BASIS_
UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productStrength
Basis[@uom]

Product Size Code String PROD_SIZE_CODE PROD_SIZE_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productSize/code

Product Size Code Maintenance Agency String PROD_SIZE_CODE_MAINT_
AGENCY

SIZE_CODE_LIST_AGENCY os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productSize/
maintenanceAgency

Product Description String PROD_DESC SHORTDESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productDescription
[@lang]; os:envelope/catalogue
Request/document/item/
targetMarketAttributes/
shortDescription[@lang]

Product Color Description String PROD_COLOR_DESC PROD_COLOR_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/color/description

Min Product Lifespan from Arrival Integer MIN_PROD_LIFE_SPAN LIFESPAN_FROM_ARRIVAL_
MIN

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/minimumTradeItem
LifespanFromArrival

Additional Description String ADDITIONAL_DESCRIPTION ADDITIONAL_DESCRIPTION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/additionalDescription

Order Sizing Factor String ORDER_SIZING_FACTOR ORDER_SIZING_FACTOR os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/orderSizingFactor

Lead Time Integer LEAD_TIME LEADTIME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/distributionDetails/
orderingLeadTime

Order Quantity Multiple Integer ORDER_QUANTITY_ ORDER_INCREMENT os:envelope/catalogueRequest/
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

MULTIPLE document/item/targetMarket
Attributes/orderQuantityMultiple

Min Order Quantity Integer MIN_ORDER_QUANTITY MINIMUMORDER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/minimumOrderQuantity

Max Order Quantity Integer MAX_ORDER_QUANTITY MAXIMUMORDER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/maximumOrderQuantity

Start Availability Date Date START_AVAILABILITY_
DATE

START_AVAILABILITY_
DATE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/startAvailabilityDate

End Availability Date Date END_AVAILABILITY_DATE END_AVAILABILITY_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endAvailabilityDate

First Ship Date Date FIRST_SHIP_DATE FIRST_SHIP_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/firstShipDate

Last Ship Date Date LAST_SHIP_DATE LAST_SHIP_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/lastShipDate

Height Decimal HEIGHT PRODUCTHEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/height

Height UOM String HEIGHT_UOM HEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/height[@uom]

Width Decimal WIDTH PRODUCTWIDTH os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/width

Width UOM String WIDTH_UOM WIDTH_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/width[@uom]

Depth Decimal DEPTH PRODUCTDEPTH os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/depth
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Depth UOM String DEPTH_UOM DEPTH_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/depth[@uom]

Non GTIN Pallet Height Decimal NGTIN_PL_HEIGHT PACKAGEDHEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletHeight

Non GTIN Pallet Height UOM String NGTIN_PL_HEIGHT_UOM NGTIN_PL_HEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletHeight[@uom]

Diameter Decimal DIAMETER DIAMETER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/diameter

Diameter UOM String DIAMETER_UOM DIAMETER_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/diameter[@uom]

Drained Weight Decimal DRAINED_WEIGHT DRAINED_WEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/drainedWeight

Drained Weight UOM String DRAINED_WEIGHT_UOM DRAINED_WEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/drainedWeight[@uom]

Gross Weight Decimal GROSS_WEIGHT GROSSWEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/grossWeight

Gross Weight UOM String GROSS_WEIGHT_UOM GROSS_WEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/grossWeight[@uom]

Non GTIN Pallet Gross Weight Decimal NGTIN_PL_GR_WEIGHT NGTIN_PL_GR_WEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPallet
GrossWeight

Non GTIN Pallet Gross Weight UOM String NGTIN_PL_GR_WEIGHT_UOM NGTIN_PL_GR_WEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPallet
GrossWeight[@uom]

Net Weight Decimal NET_WEIGHT NETWEIGHT os:envelope/catalogueRequest/
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

document/item/targetMarket
Attributes/netWeight

Net Weight UOM String NET_WEIGHT_UOM NET_WEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/netWeight[@uom]

Packaging Material Composition String PACKAGING_WEIGHT PACKAGING_WEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial
[@uom]

Packaging Material Composition UOM String PACKAGING_WEIGHT_UOM PACKAGING_WEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial
[@uom]

Peg Horizontal Decimal PEG_HORIZONTAL PEG_HORIZONTAL os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegHorizontal

Peg Horizontal UOM String PEG_HORIZONTAL_UOM PEG_HORIZONTAL_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegHorizontal[@uom]

Peg Vertical Decimal PEG_VERTICAL PEG_VERTICAL os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegVertical

Peg Vertical UOM String PEG_VERTICAL_UOM PEG_VERTICAL_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegVertical[@uom]

Volume Decimal VOLUME VOLUME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/volume

Volume UOM String VOLUME_UOM VOLUME_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/volume[@uom]

Percentage of Alcohol per Volume Decimal PERCENT_ALCOHOL_PER_
VOL

PERCENT_ALCOHOL os:envelope/catalogueRequest/
document/item/targetMarket
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Attributes/percentageOf
AlcoholPerVolume

Packaging Material Code String PACKAGING_MATERIAL_
CODE

PKG_MATERIAL_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/packaging
Material/packagingMaterial
TypeCode

Product Marked with Ingredients Boolean PROD_MARKEDWITH_
INGREDIENTS

WITH_INGREDIENTS os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productMarked
WithIngredients

Product Marked Recyclable Boolean PROD_MARKED_RECYCLABLE PROD_MARKED_RECYCLABLE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productMarked
Recyclable

Packaging Marked Returnable Boolean PACKAGE_MARKED_
RETURNABLE

PACKAGE_MARKED_
RETURNABLE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMarked
Returnable

Dispatch Unit Indicator Boolean DISPATCH_UNIT_
INDICATOR

DESPATCH_UNIT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isDispatchUnit

Invoice Unit Indicator Boolean INVOICE_UNIT_INDICATOR INVOICE_UNIT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isInvoiceUnit

Ordering Unit Indicator Boolean ORDERING_UNIT_
INDICATOR

ORDERING_UNIT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isOrderableUnit

Handling Instruction Code String PROD_HANDLING_
INSTRUCTION

SPECIAL_HANDLING_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/handlingInstructions/
handlingInstructionCode

Max Stacking Weight Decimal MAX_ADM_STACKING_
WEIGHT

STACKING_WEIGHT_MAX os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemStacking/
stackingWeightMaximum
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Max Stacking Weight UOM String MAX_ADM_STACKING_
WEIGHT_UOM

MAX_ADM_STACKING_
WEIGHT_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/maximumStacking
Weight[@uom]

Stacking Factor Integer STACKING_FACTOR STACKING_FACTOR os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemStacking/
stackingFactor

Pallet Code String PALLET_CODE PALLET_TYPE_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
platformTypeCode

Pallet Terms and Conditions String PALLET_HANDL_ONEWAY_
REUSE

PALLET_HANDL_ONEWAY_
REUSE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingInformation/
platformTermsAnd
ConditionsCode

Dangerous Goods Hazardous Code String HAZARD_CODE HAZMAT_CODE1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/hazardous
InformationHeader/hazardous
InformationDetail/dangerous
GoodsHazardousCode

Dangerous Goods Class Code String HAZMAT_CLASS_CODE HAZMAT_CLASSCODE1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/hazardous
InformationHeader/hazardous
InformationDetail/classOf
DangerousGoods

Dangerous Goods Regulation Code String HAZARD_TYPE_CLASS_
SYSTEM

HAZARD_TYPE_CLASS_
SYSTEM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
transportationClassification/
regulatedTransportationMode/
hazardousInformationHeader/
dangerousGoods
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

RegulationCode

U.N. Dangerous Goods Number String DANGEROUS_GOODS_SUB_ID DANGEROUS_GOODS_
HAZARD_CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/hazardous
InformationHeader/hazardous
InformationDetail/unitedNations
DangerousGoodsNumber

Dangerous Goods Packing Group String DANGEROUS_GOODS_PACK_
GROUP

DANGEROUS_GOODS_PACK_
GROUP

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/
hazardousInformationHeader/
hazardousInformationDetail/
dangerousGoodsPackingGroup

Dangerous Goods Shipping Name String DANGEROUS_GOODS_SHIP_
NAME

DANGEROUS_GOODS_SHIP_
NAME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/
hazardousInformationHeader/
hazardousInformationDetail/
dangerousGoodsShippingName

Dangerous Goods Technical Name String DANGEROUS_GOODS_TECH_
NAME

DANGEROUS_GOODS_TECH_
NAME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/transportation
Classification/regulated
TransportationMode/
hazardousInformationHeader/
hazardousInformationDetail/
dangerousGoodsTechnicalName

Flash Point Temperature Decimal FLASHPOINT_TEMP FLASHPOINT_TEMP1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
transportationClassification/
regulatedTransportationMode/
hazardousInformationHeader/
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

flashPointTemperature

Flash Point Temperature UOM String FLASHPOINT_TEMP_UOM FLASHPOINT_UNITS1 os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/transportation
Classification/hazardous
InformationHeader/flashPoint
Temperature

Hazmat Special Instructions String HAZMAT_SPECIAL_
INSTRUCTIONS

HAZMAT_SPECIAL_
INSTRUCTIONS

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/hazardousMaterial/
dangerousGoods/
specialInstructions

Trade Item Group Code String TRADEITEM_GROUP_CODE TRADEITEM_GROUP_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemGroup
Identification/tradeItemGroup
IdentificationCodeReference

Trade Item Group Description String TRADEITEM_GROUP_DESC TRADEITEM_GROUP_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemGroup
Identification/tradeItemGroup
IdentificationCodeDescription

Pricing On Product Boolean PRICING_ON_PRODUCT PRICE_ON_PACKAGE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pricingOnProduct

Material Safety Data Sheet Number String MAT_SAFETY_DATASHEET_
NUM

MAT_SAFETY_DATASHEET_
NUM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/safetyDataSheet
Information/sDSSheetNumber

Number of Layers Per Pallet/Non GTIN Pallet Hi Integer N_GTIN_PALLET_HI N_GTIN_PALLET_HI os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletHi

Number of Trade Items Per Pallet Layer/Non GTIN Pallet Ti Integer N_GTIN_PALLET_TI N_GTIN_PALLET_TI os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonGTINPalletTi

Alternate Item Classification Scheme String CLASSIFICATION_SCHEME CLASSIFICATIONSCHEME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateClassification/scheme
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Color String COLOR COLOR os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/color

Color Code Maintenance Agency String COLOR_CODE_MNT_AGENCY COLOR_CODE_AGENCY os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/color/agency

List Price Decimal LIST_PRICE LIST_PRICE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/price

List Price Currency String LIST_PRICE_CURRENCY PRICEUOMCODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/price
[@currency]

List Price Basis Per Unit Decimal LIST_PRICE_
BASISPERUNIT

LIST_PRICE_BASIS_PER_
UNIT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
basisPerUnit

List Price Basis Per Unit UOM String LIST_PRICE_
BASISPERUNIT_UOM

LIST_PRICE_
BASISPERUNIT_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
basisPerUnit[@uom]

Suggested Retail Price Amount RECOMMEND_SALES_PRICE SUGGESTED_RETAIL_PRICE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
price[@currency]

Suggested Retail Price Currency String RECOMMEND_PRICE_
CURRENCY

RECOMMEND_PRICE_
CURRENCY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
price[@currency]

Suggested Retail Price Basis Per Unit Decimal RECOMMEND_PRICE_
PERUNIT

RECOMMEND_PRICE_
PERUNIT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
basisPerUnit[@uom]

Suggested Retail Price Basis Per Unit UOM String RECOMMEND_PRICE_
PERUNIT_UOM

RECOMMEND_PRICE_
PERUNIT_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
basisPerUnit[@uom]
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Right of Return for Non-Sold Trade Item Boolean RIGHT_RETURN_NSOLD_
TRADE

RIGHT_RETURN_NSOLD_
TRADE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/rightOfReturn
ForNonSoldTradeItem

Tax Rate Decimal TAX_RATE TAX_RATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/rate

Tax (Rate) Type Code String TAX_TYPE TAX_TYPE_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/typeCode

Alternate Item Number String ALTERNATE_ITEM_ID ALTERNATE_ID os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateItem
Identification/id

Alternate Item Identification Maintenance Agency String ALTERNATE_ITEMID_MNT_
AGENCY

ALTERNATE_ITEMID_MNT_
AGENCY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/alternateItem
Identification/agency

Replaced by GTIN String REPLACED_ITEM_GTIN REPLACED_BY_GTIN os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/referencedTradeItem/
referencedTradeItemGTIN/
referencedTradeItem/referenced
TradeItemTypeCode=
REPLACED_BY

Organic Trade Item Code String ORGANIC ORGANIC_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/organic/organicClaim/
organicTradeItemCode

Degree of Original Wort String DEGREE_OF_ORIGINAL_
WORT

DEGREE_OF_ORIGINAL_
WORT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/degreeOfOriginalWort

Fat Content UOM String FAT_CONTENT_UOM FAT_CONTENT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/fatContent[@uom]

Fat Content Basis of Measure UOM String FAT_CONTENT_BASIS_UOM FAT_CONTENT_BASIS_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/fatContentBasisOf
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Measure[@uom]

Units Per Consumer Unit Integer UNITS_PER_CONSUMER_
UNIT

UNITS_PER_CONSUMER_
UNIT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/unitsPerConsumerUnit

Total Units per Case Integer TOTAL_UNITS_PER_CASE UNITS_PER_CASE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/totalUnitsPerCase

Pricing Item Indicator Boolean PRICING_ITEM_INDICATOR PRICING_ITEM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pricingItemIndicator

NA Date PUBLISH_DATE PUBLISH_DATE os:envelope/catalogueRequest/
document/publication/publishDate

First Order Date Date FIRST_ORDER_DATE FIRST_ORDER_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/firstOrderDate

Last Order Date Date LAST_ORDER_DATE LAST_ORDER_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/lastOrderDate

Global Classification Code String ALT_ITEM_CLASSN_CODE ADDITIONAL_CLASS_CAT_
CODE

os:envelope/catalogueRequest/
document/item/globalAttributes/
globalClassificationCategory/code

Pricing Pack Decimal PRICING_PACK PRICING_PACK os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pricingPack

List Price Effective Start Date Date LIST_PRICE_DATE_START LIST_PRICE_DATE_START os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
effectiveStartDate

List Price Effective End Date Date LIST_PRICE_DATE_END LIST_PRICE_DATE_END os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/cataloguePrice/
effectiveEndDate

Special Item Code String SPECIAL_ITEM_CODE SPECIAL_ITEM_CODE os:envelope/catalogueRequest/
document/item/globalAttributes/
marketingInformation/
specialItemCode
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Feature Benefit String FEATURED_PRODUCT_DESC FEATURED_PRODUCT_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemFeatureBenefit

Is Raw Material Irradiated String RAW_MATERIAL_
IRRADIATED

RAW_MATERIAL_
IRRADIATED

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isRawMaterialIrradiated

Is Ingredient Irradiated String INGREDIENT_IRRADIATED INGREDIENT_IRRADIATED os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isIngredientIrradiated

Peg Hole Number Integer PEG_HOLE_NUMBER PEG_HOLE_NUMBER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/pegMeasurements/
pegHoleNumber

Barcode Type String BAR_CODE_TYPE BAR_CODE_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/dataCarrierTypeCode

Country of Assembly String TRADE_ITEM_COUNTRY_
ASSEMBLY

TRADE_ITEM_COUNTRY_
ASSEMBLY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemCountry
OfAssembly

Variable Trade Item Type String VARIABLE_TRADE_ITEM_
TYPE

VARIABLE_TRADE_ITEM_
TYPE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/variableTradeItemType

Campaign End Date Date CAMPAIGN_END_DATE CAMPAIGN_END_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/campaignEndDate

Campaign Name String CAMPAIGN_NAME CAMPAIGN_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productActivityDetails/
countryOfActivity/countryCode

Campaign Start Date Date CAMPAIGN_START_DATE CAMPAIGN_START_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/campaignStartDate

Marketing Message String TRADE_ITEM_MARKETING_
MESSAGE

TRADE_ITEM_MARKETING_
MESSAGE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItem
MarketingMessage
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Season Calendar Year Integer SEASON_CALENDAR_YEAR SEASON_CALENDAR_YEAR os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/
seasonCalendarYear

Season Name String SEASON_NAME SEASON_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/seasonName

Season Parameter String SEASON_PARAMETER SEASON_PARAMETER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/
seasonParameter

Seasonal Start Date Date SEASON_AVAIL_START_
DATE

SEASON_AVAIL_START_
DATE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/seasonal
AvailabilityStartDate

Seasonal End Date Date SEASON_AVAIL_END_DATE SEASON_AVAIL_END_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/season/seasonal
AvailabilityEndDate

Target Consumer Age String TARGET_CONSUMER_AGE TARGET_CONSUMER_AGE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetConsumerAge

Target Consumer Gender String TARGET_CONSUMER_GENDER TARGET_CONSUMER_GENDER os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetConsumerGender

Feature Benefit String TRADE_ITEM_FEATURE_
BENEFIT

TRADE_ITEM_FEATURE_
BENEFIT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemFeatureBenefit

Compliance Regulation Code String CLASS_COMPLIANCE_REG_
CODE

CLASS_COMPLIANCE_REG_
CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/regulatoryInformation/
regulationTypeCode

Import Classification Type String IMPORT_CLASS_TYPE IMPORT_CLASS_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/importIdentification/
importClassification/import
ClassificationTypeCode
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Import Classification Value String IMPORT_CLASS_VALUE IMPORT_CLASS_VALUE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/importClassification/
importClassificationValue

Max DC Delivery Temp Decimal DELIVERY_DC_TEMP_MAX DELIVERY_DC_TEMP_MAX os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/maximumTemperature

Max DC Delivery Temp UOM String DELIVERY_DC_TEMP_UOM DELIVERY_DC_TEMP_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/deliveryToDC
TemperatureMaximum[@uom]

Max Market Delivery Temp Decimal DELIVERY_MARKET_TEMP_
MAX

DELIVERY_MARKET_TEMP_
MAX

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/maximumTemperature

Max Market Delivery Temp UOM String DELIVERY_MARKET_TEMP_
UOM

DELIVERY_MARKET_TEMP_
UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/deliveryToMarket
TemperatureMaximum[@uom]

Max Storage Humidity Decimal STORAGE_HUMIDITY_MAX STORAGE_HUMIDITY_MAX os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemHumidity
Information/maximumHumidity
Percentage

Min DC Delivery Temp Decimal DELIVERY_DC_TEMP_MIN DELIVERY_DC_TEMP_MIN os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/minimumTemperature

Min Market Delivery Temp Decimal DELIVERY_MARKET_TEMP_
MIN

DELIVERY_MARKET_TEMP_
MIN

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemTemperature
Information/minimumTemperature

Min Storage Humidity Decimal STORAGE_HUMIDITY_MIN STORAGE_HUMIDITY_MIN os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemHumidity
Information/minimumHumidity
Percentage
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Product Range String PRODUCT_RANGE PRODUCT_RANGE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/productRange

Inner Pack String QUANTITY_OF_INNER_PACK QUANTITY_OF_INNER_PACK os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/innerPack

Composition Width Decimal TRADE_ITEM_COMPOS_
WIDTH

TRADE_ITEM_COMPOS_
WIDTH

os:envelope/catalogueRequest/
document/item/globalAttributes/
tradeItemCompositionWidth

Composition Width UOM String TRADE_ITEM_COMPOS_
WIDTH_UOM

TRADE_ITEM_COMPOS_
WIDTH_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemComposition
Width[@uom]

Descriptive Size Dim String DESCRIPTIVE_SIZE_
DIMENSION

DESCRIPTIVE_SIZE_
DIMENSION

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/
nonPackagedSizeDimension/
descriptiveSizeDimension

Material Code String MATERIAL_CODE MATERIAL_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
textileMaterial/textileMaterial
Composition/materialCode

Material Content String MATERIAL_CONTENT MATERIAL_CONTENT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
materialComposition/
materialContent

Material Percentage Decimal MATERIAL_PERCENTAGE MATERIAL_PERCENTAGE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
textileMaterial/textileMaterial
Composition/materialPercentage

Material Weight Integer MATERIAL_WEIGHT MATERIAL_WEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/textileMaterial/
textileMaterialComposition/
materialWeight
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Material Weight UOM String MATERIAL_WEIGHT_UOM MATERIAL_WEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialWeight[@uom]

Organic Claim Agency String ORGANIC_CLAIM_AGENCY ORGANIC_CLAIM_AGENCY os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/organic/organicClaim/
organicClaimAgencyCode

Size Dimension Decimal SIZE_DIMENSION SIZE_DIMENSION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/non
PackagedSizeDimension/
sizeDimension

Size Dimension UOM String SIZE_DIMENSION_UOM SIZE_DIMENSION_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/size
Dimension[@uom]

Size Group String SIZE_GROUP SIZE_GROUP os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
sizeGroupCode

Size System String SIZE_SYSTEM SIZE_SYSTEM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/size
SystemCode

Size Type String SIZE_TYPE SIZE_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonPackageDimensions/
nonPackageSizeDimension/size
TypeCode

Thread Count String THREAD_COUNT THREAD_COUNT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/textileMaterial/
textileMaterialComposition/
materialThreadCount

Consumer Availability Date Date CONSUMER_UNIT_AVAIL_
DATE

CONSUMER_UNIT_AVAIL_
DATE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/consumerAvailability
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DateTime

End Date of Exclusivity Date END_DATE_OF_
EXCLUSIVITY

END_DATE_OF_
EXCLUSIVITY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endDate
TimeOfExclusivity

End Date of Max Buying Qty Date END_DATE_MAX_BUYING END_DATE_MAX_BUYING os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endDateMaximum
BuyingQuantity

End Date of Min Buying Qty Date END_DATE_MIN_BUYING END_DATE_MIN_BUYING os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/endDateMinimumvBuyingQuantity

First Delivery Date Date FIRST_DELIVERY_DATE_
TIME

FIRST_DELIVERY_DATE_
TIME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/firstDeliveryDateTime

Start Date of Max Buying Qty Date START_DATE_MAX_BUYING_
QTY

START_DATE_MAX_BUYING_
QTY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/startDateMaximum
BuyingQuantity

Start Date of Min Buying Qty Date START_DATE_MIN_BUYING_
QTY

START_DATE_MIN_BUYING_
QTY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/startDateMinimum
BuyingQuantity

Deposit Value End Date Date DEPOSIT_VAL_END_DATE DEPOSIT_VAL_END_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/returnablePackage
DepositAmount

Deposit Value Start Date Date DEPOSIT_VAL_EFF_DATE DEPOSIT_VAL_EFF_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/depositValueEffectiveDate

Offer On Pack String OFFER_ON_PACK OFFER_ON_PACK os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/offerOnPack
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Package Marks Diet Allergen String PACKAGE_MARKS_DIET_
ALLERGEN

PACKAGE_MARKS_DIET_
ALLERGEN

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packageMarks
DietAllergen

Package Marks Environment String PACKAGE_MARKS_
ENVIRONMENT

PACKAGE_MARKS_
ENVIRONMENT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packaging
MarkedLabelAccreditationCode

Package Marks Ethical String PACKAGE_MARKS_ETHICAL PACKAGE_MARKS_ETHICAL os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packaging
MarkedLabelAccreditationCode

Package Marks Free From String PACKAGE_MARKS_FREE_
FROM

PACKAGE_MARKS_FREE_
FROM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packageMarksFreeFrom

Packaging Marked Expiration Date Type String PKG_MARKED_EXPIRE_
DATE_TYPE

PKG_MARKED_EXPIRE_
DATE_TYPE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingDate/
tradeItemDateOnPackaging
TypeCode

Packaging Marked Recyclable Scheme String PKG_MARKED_RECYCLE_
SCHEME

PKG_MARKED_RECYCLE_
SCHEME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMarked
RecyclableScheme

Returnable Package Deposit Amount Amount RETURNABLE_PKG_
DEPOSIT_AMT

RETURNABLE_PKG_
DEPOSIT_AMT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/returnablePackage
DepositAmount

Returnable Package Deposit Code String RETURNABLE_PKG_
DEPOSIT_CODE

RETURNABLE_PKG_
DEPOSIT_CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/package
deposit/returnablePackage
DepositAmount

Security Tag Location String SECURITY_TAG_LOCATION SECURITY_TAG_LOCATION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/securityTagInformation/
securityTagLocationCode
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Security Tag Type String SECURITY_TAG_TYPE SECURITY_TAG_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/securityTagInformation/
securityTagTypeCode

Terms or Conditions Code Varchar PACKAGING_TERMS_
CONDITIONS

PACKAGING_TERMS_
CONDITIONS

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
packagingInformation/packaging
TermsAndConditionsCode

Generic Ingredient String GENERIC_INGREDIENT GENERIC_INGREDIENT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
nonFoodIngredientName

Generic Ingredient Strength String GENERIC_INGREDIENT_
STRENGTH

GENERIC_INGREDIENT_
STRENGTH

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/nonFoodIngredient/
ingredientStrength/
ingredientStrength

Generic Ingredient Strength UOM String GENERIC_INGREDIENT_
STR_UOM

GENERIC_INGREDIENT_
STR_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/genericIngredient
Strength[@uom]

Goods Pick Up Lead Time Decimal GOODS_PICKUP_LEAD_TIME GOODS_PICKUP_LEAD_TIME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/goodsPickUpLeadTime

Goods Pick Up Lead Time UOM String GOODS_PICKUP_LEAD_
TIME_UOM

GOODS_PICKUP_LEAD_
TIME_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/goodsPickUpLeadTime[@uom]

Invoice Name String INVOICE_NAME INVOICE_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/invoiceName

Is Size Based Pricing Boolean IS_TRADEITEM_SIZE_
BASED_PRIC

IS_TRADEITEM_SIZE_
BASED_PRIC

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isTradeItemSize
BasedPricing

Is Trade Item Reorderable Boolean IS_REORDERABLE IS_REORDERABLE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/isTradeItemReorderable
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Ordering UOM String ORDERING_UOM ORDERING_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/orderingUnitOfMeasure

Selling UOM String SELLING_UOM SELLING_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/sellingUnitOfMeasure

Max Buying Quantity Integer AGREED_MAX_BUYING_
QUANTITY

AGREED_MAX_BUYING_
QUANTITY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/agreedMaximum
BuyingQuantity

Min Buying Quantity Integer AGREED_MIN_BUYING_
QUANTITY

AGREED_MIN_BUYING_
QUANTITY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/agreedMinimum
BuyingQuantity

Price By Measure Type String PRICE_BY_MEASURE_TYPE PRICE_BY_MEASURE_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceByMeasureType

Price Comparison Measurement Decimal PRICE_COMP_MEASUREMENT PRICE_COMP_MEASUREMENT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceComparison
Measurement

Price Comparison Measurement UOM String PRICE_COMP_UOM PRICE_COMP_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceComparison
Measurement[@uom]

Retail Price On Trade Item Amount RETAIL_PRICE_ON_ITEM RETAIL_PRICE_ON_ITEM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/additionalTradeItem
Price/tradeItemPrice

Price Comparison Content Type String PRICE_COMP_CONTENT_
TYPE

PRICE_COMP_CONTENT_
TYPE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/priceComparison
ContentType

Suggested Retail Price Effective End Date Date EFFECTIVE_END_DATE EFFECTIVE_END_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
effectiveEndDate
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Suggested Retail Price Effective Start Date Date EFFECTIVE_START_DATE EFFECTIVE_START_DATE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/suggestedRetail/
effectiveStartDate

Tax Amount Amount TAX_AMOUNT TAX_AMOUNT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/duty
FeeTaxInformation/dutyFeeTax/
dutyFeeTaxAmount

Tax Amount Currency String CURRENCY_CODE CURRENCY_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/currency

Tax (Rate) Type Agency String TAX_AGENCY_CODE TAX_AGENCY_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/agencyCode

Tax (Rate) Type Description String TAX_TYPE_DESC TAX_TYPE_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/typeDescription

Finish Description String TRADE_ITEM_FINISH_DESC TRADE_ITEM_FINISH_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/tradeItemFinishDescription

Min Product Lifespan from Production String MINLIFE_SPAN_FROM_
PRODUCTION

MIN_LIFE_SPAN_TIME_OF_
PUB

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/minimum
TradeItemLifespanFromProduction

Retail Price On Trade Item Currency String RETAIL_PRICE_ON_ITEM_
CURR

RETAIL_PRICE_ON_ITEM_
CURR

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/retailPriceOn
TradeItem[@currency]

Returnable Package Deposit Currency String RETURN_PKG_DEPOSIT_
AMT_CURR

RETURN_PKG_DEPOSIT_
AMT_CURR

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMaterial/
returnablePackageDeposit
Amount[@currency]

Tax (Amount) Type Description String TAX_AMT_TAX_TYPE_DESC TAX_AMT_TAX_TYPE_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/dutyFee
TaxInformation/dutyFeeTax
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TypeDescription

Tax (Amount) Type Agency String TAX_AMT_TAX_AGENCY_
CODE

TAX_AMT_TAX_AGENCY_
CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/dutyFee
TaxInformation/dutyFeeTax
Agency/AgencyCode

Tax (Amount) Type Code String TAX_AMT_TAX_TYPE_CODE TAX_AMT_TAX_TYPE_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/dutyFee
TaxInformation/dutyFeeTax
TypeCode

Material Agency Code String MATERIAL_AGENCY_CODE MATERIAL_AGENCY_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/materialComposition/
textileMaterial/material
AgencyCode

Is Barcode Symbology Derivable Boolean ISBARCODEDERIVABLE ISBARCODEDERIVABLE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gs1TradeItem
IdentificationKey/isBarcode
SymbologyDerivable

Lead Time UOM String LEADTIMEUOM LEADTIMEUOMCODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/leadTime[@uom]

TM Subdivision String TARGET_MARKET_
SUBDIVISION

TARGET_MARKET_
SUBDIVISION

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/targetMarket
SubdivisionCode

Party Receiving Private Data String PARTY_RECEIVING_
PRIVATE_DATA

PARTY_RECEIVING_
PRIVATE_DATA

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/partyReceivingP
rivateDataGLN

GTIN Variation Registry Boolean GTIN_VARIATION_
REGISTRY

GTIN_VARIATION_
REGISTRY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/gtinVariationRegistry

Manufacturer Name String MANUFACTURER_NAME MANUFACTURER_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/manufacturer/name
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Green Dot Indicator Boolean GREEN_DOT_INDICATOR PACKAGE_MARKED_GREEN_
DOT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/greenDotIndicator

Order Sizing Factor UOM String ORDER_SIZING_FACTOR_
UOM

ORDER_SIZING_FACTOR_
UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/orderSizingFactor[@uom]

GLN Of Ship From Party String SHIP_LOCATION_GLN SHIP_LOCATION_GLN os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/partyInRole/
gln with partyRoleCode = SHIP_FROM

Name Of Ship From Party String SHIP_LOCATION_NAME SHIP_LOCATION_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/partyInRole/
name with partyRoleCode = SHIP_FROM

Uniform Resource Identifier String URI URI os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='externalFileLink']/row/
attr[@name='uniformResource
Identifier']

Link File Name String FILE_NAME_EXT FILE_NAME_EXT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='externalFileLink']/row/
attr[@name='externalFile
LinkFileName']

File Format Name String FILE_FORMAT_NAME FILE_FORMAT_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='externalFileLink']/row/
attr[@name='fileFormatName']

File Effective Start Date Date FILE_EFFECTIVE_START_
DATE

FILE_EFFECTIVE_START_
DATE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='externalFileLink']/row/
attr[@name='fileEffective
StartDateTime']

File Effective End Date Date FILE_EFFECTIVE_END_
DATE

FILE_EFFECTIVE_END_
DATE

os:envelope/catalogueRequest/
document/item/targetMarket
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Attributes/flex/attrGroupMany
[@name='externalFileLink']/row/
attr[@name='fileEffective
EndDateTime']

Link Content Description String CONTENT_DESC CONTENT_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroup
Many/row/attrQualMany
[@name='externalFileLink
ContentDescription']/value

File Format Description String FILE_FORMAT_DESC FILE_FORMAT_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroup
Many/row/attrQualMany
[@name='fileFormat
Description']/value

Consumer Usage Storage Instructions String STORAGE_INSTRUCTION STORAGE_INSTRUCTION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name='consumerUsage
StorageInstructions']/value

Layer Height Decimal LAYER_HEIGHT LAYER_HEIGHT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name='layerHeight']

Layer Height UOM String LAYER_HEIGHT_UOM LAYER_HEIGHT_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name='layerHeight'][@qual]

Type Of Information String TYPE_INFORMATION TYPE_INFORMATION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='externalFileLink']/row/attr
[@name='typeOfInformation']

Is Trade Item Packed Irregularly? String IS_ITEM_PACKED_
IRREGULARLY

SHIP_LOCATION_NAME os:envelope/catalogueRequest/
document/item/globalAttributes/
isTradeItemPackedIrregularly

Item Composition Depth Decimal ITEM_COMPOSITION_DEPTH ITEM_COMPOSITION_DEPTH os:envelope/catalogueRequest/
document/item/globalAttributes/
tradeItemCompositionDepth
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Item Composition Depth UOM Varchar ITEM_COMPOSITION_
DEPTH_UOM

ITEM_COMPOSITION_
DEPTH_UOM

os:envelope/catalogueRequest/
document/item/globalAttributes/
tradeItemCompositionDepth/
@uom

Package Marks Hygienic String PKG_MARKED_HYGIENIC PKG_MARKED_HYGIENIC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/packagingMarked
LabelAccreditationCode

Tax Rate Applicability Code String TAX_RATE_
APPLICABILITY_CODE

TAX_RATE_
APPLICABILITY_CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxRate/taxRate
ApplicabilityCode

Tax Amount Applicability Code String TAX_AMT_APPLICABILITY_
CODE

TAX_AMT_APPLICABILITY_
CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/taxAmount/tax
AmountApplicabilityCode

Clamp Pressure Decimal CLAMP_PRESSURE CLAMP_PRESSURE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name='clampPressure']

Clamp Pressure UOM String CLAMP_PRESSURE_UOM CLAMP_PRESSURE_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQual
[@name='clampPressure'][@qual]

Orientation Type String ORIENTATION_TYPE ORIENTATION_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='tradeItemOrientation']
/row/attr[@name='orientation
Type']

Orientation Preference Sequence Integer ORIENTATION_PREF_SEQ ORIENTATION_PREF_SEQ os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='tradeItemOrientation']/
row/attr[@name='orientation
PreferenceSequence']

Nesting Direction String NESTING_DIRECTION NESTING_DIRECTION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/tradeItemNesting/
nestingTypeCode
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Nesting Type String NESTING_TYPE NESTING_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/tradeItemNesting/
nestingDirectionCode

Has Display Ready Packaging? String HAS_DISPLAY_READY_PKG HAS_DISPLAY_READY_PKG os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name='hasDisplayReadyPackaging']

Electrical Usage Trade Item Classification Agency String ELEC_USAGE_CLASS_
AGENCY

ELEC_USAGE_CLASS_
AGENCY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsageTrade
ItemClassification/physical
ResourceUsageClassification
Agency

Electrical Usage Trade Item Classification Name String ELEC_USAGE_CLASS_NAME ELEC_USAGE_CLASS_NAME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsageTrade
ItemClassification/physical
ResourceUsageClassificationName

Electrical Usage Subclassification Name String ELEC_USAGE_SUBCLASS_
NAME

ELEC_USAGE_SUBCLASS_
NAME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physicalResource
UsageInformation/physicalResource
UsageTradeItemClassification/
physicalResourceUsage
SubclassificationAgency

Display Dimension Type Code String DISPLAY_DIMENSION_CODE DISPLAY_DIMENSION_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attr[@name='display
DimensionTypeCode']

Dimension Depth Integer DISPLAY_DIMENSION_
DEPTH

DISPLAY_DIMENSION_
DEPTH

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attrQual[@name='dimension
Depth']
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Dimension Depth UOM String DISPLAY_DIMENSION_
DEPTH_UOM

DISPLAY_DIMENSION_
DEPTH_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attrQual[@name='dimension
Depth'][@qual]

Dimension Width Integer DISPLAY_DIMENSION_
WIDTH

DISPLAY_DIMENSION_
WIDTH

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attrQual[@name='dimension
Width']

Dimension Width UOM String DISPLAY_DIMENSION_
WIDTH_UOM

DISPLAY_DIMENSION_
WIDTH_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attrQual[@name='dimension
Width'][@qual]

Dimension Height Integer DISPLAY_DIMENSION_
HEIGHT

DISPLAY_DIMENSION_
HEIGHT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attrQual[@name='dimension
Height']

Dimension Height UOM String DISPLAY_DIMENSION_
HEIGHT_UOM

DISPLAY_DIMENSION_
HEIGHT_UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='displayDimensions']/
row/attrQual[@name='dimension
Height'][@qual]

Warranty Effective Date Type String WARRANTY_EFF_DATE_TYPE WARRANTY_EFF_DATE_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warranty
EffectiveDateType

Warranty Type String WARANTY_TYPE WARANTY_TYPE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warrantyType

Warranty Constraint String WARRANTY_CONSTRAINT WARRANTY_CONSTRAINT os:envelope/catalogueRequest/
document/item/targetMarket
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Attributes/flex/warranty
Information/warrantyConditions/
warrantyConstraint

Warranty Period Integer WARRANTY_DURATION WARRANTY_DURATION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warrantyConditions/
warrantyDuration

Warranty Information Description String WARRANTY_DESC WARRANTY_DESC os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warrantyDescription

Is Product A Pesticide? String CONTAINS_PESTICIDE CONTAINS_PESTICIDE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/doesTrade
ItemContainPesticide

Is Product Aerosol? String CONTAINS_PROPELLANT CONTAINS_PROPELLANT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name='isProductAerosol']

Is Product Chemical Not Intended For Human
Consumption?

String CHEMICAL_FOR_HUMAN_
CONSUME

CHEMICAL_FOR_HUMAN_
CONSUME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name='isProductChemicalNot
IntendedForHumanConsumption']

Percentage Of Plastic Components Made From a Plant
Based Material

Integer RENEWABLE_PLASTIC_
PERCENT

RENEWABLE_PLASTIC_
PERCENT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/renewablePlant
BasedPlasticComponentsPercent

Is Product Subject To A Manufacturer Take Back Program? String TAKE_BACK_PROGRAM TAKE_BACK_PROGRAM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/doesManufacturer
HaveTakeBackProgram

Manufacturer Take Back Program Fee Integer TAKE_BACK_PROGRAM_FEE TAKE_BACK_PROGRAM_FEE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name='manufacturer
TakeBackProgramFee']/value
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Packaging Marked Recyclable Scheme String PKG_MARKED_RECYCLABLE PKG_MARKED_RECYCLABLE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/packagingMarked
RecyclableScheme

Trade Item Default Time Limit Of Auto Power Down
Function Value

Date POWER_DOWN_DEF_TIME POWER_DOWN_DEF_TIME os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name='tradeItemDefaultTime
LimitOfAutoPowerDown
FunctionValue']

Trade Item Default Time Limit Of Auto Power Down
Function UOM

String POWER_DOWN_DEF_TIME_
UOM

POWER_DOWN_DEF_TIME_
UOM

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name='tradeItemDefaultTime
LimitOfAutoPowerDown
FunctionUOM']

Electrical Usage Agency Code String ELE_USAGE_AGENCY_CODE ELE_USAGE_AGENCY_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrMany
[@name='electricalUsageAgency
Code']/value

Is Trade Item Auto Powered Down Enabled When Shipped
To Customer

String POWER_DOWN_ENABLED POWER_DOWN_ENABLED os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTradeItem
AutomaticPowerDownEnabled

Electrical Usage Class Code String ELEC_USAGE_CLASS_CODE ELEC_USAGE_CLASS_CODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsageTrade
ItemClassification/physical
ResourceUsageClassification
Code

Electrical Usage Sub Class Code String ELEC_USAGE_SUBCLASS_
CODE

ELEC_USAGE_SUBCLASS_
CODE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsage
TradeItemClassification/
physicalResourceUsageSub
classificationCode
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Maximum Energy Usage Time Period Decimal MAX_ENERGY_USAGE MAX_ENERGY_USAGE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsage/physical
ResourceUsage

Maximum Energy Usage Time Period UOM String MAX_ENERGY_USAGE_UOM MAX_ENERGY_USAGE_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='electricalUsage']/row/
attrQual[@name='maximum
EnergyUsageTimePeriod']
[@qual]

Electrical Usage Class Screen Area Value String TOTAL_SCREEN_AREA TOTAL_SCREEN_AREA os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/totalScreenArea

Electrical Usage Class Screen Area UOM String TOTAL_SCREEN_AREA_UOM TOTAL_SCREEN_AREA_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name='electricalUsageClass
ScreenAreaValue']/value[@qual]

Electrical Usage Class Resolution Code String DISPLAY_RESOLUTION DISPLAY_RESOLUTION os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/displayResolution
Code

Electrical Usage Class Mode Code String RUN_MODE RUN_MODE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/physical
ResourceUsageInformation/
physicalResourceUsage/
runModeCode

Manufacturer Take Back Program Currency String TAKE_BACK_PROGRAM_FEE_
CURR

TAKE_BACK_PROGRAM_FEE_
CURR

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrQualMany
[@name='manufacturerTakeBack
ProgramFee']/value[@qual]

Warranty Condition Effective Date Type String WARRANTY_CON_EFF_DATE_
TYPE

WARRANTY_CON_EFF_DATE_
TYPE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/warranty
Information/warranty
EffectiveDateType
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Warranty Period UOM String WARRANTY_DURATION_UOM WARRANTY_DURATION_UOM os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrGroupMany
[@name='warrantyConditionInfo']/
row/attr[@name=warranty
Period']

Country of Last Provenance/Processing String COUNTRY_LAST_
PROVENANCE

COUNTRY_OF_LAST_
PROCESSING

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/productActivity
Details/countryOfActivity/
countryCode productActivityType
Code=LAST_PROCESSING

Trade Channel String TRADE_CHANNEL TRADE_CHANNEL os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attrMany
[@name='tradeChannel']/value

Is Hazardous Component Broken Down Easily For Recycling String HAZARDOUS_COMP_
REMOVABLE

HAZARDOUS_COMP_
REMOVABLE

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/areHazardous
ComponentsRemovable

Percent Of Product Components Labeled For Disassembly
And Recycling

Decimal DISASSEMBLY_RECYCLE_
PERCENT

DISASSEMBLY_RECYCLE_
PERCENT

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/components
LabeledForDisassembly
RecyclingPercen

Is Product Disassembly By Recycling Facility Completed
Using Standard Tools

String DESIGN_FOR_EASY_
DISASSMBLY

DESIGN_FOR_EASY_
DISASSMBLY

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr
[@name='isProductDisassembly
ByRecyclingFacilityCompleted
UsingStandardTools']

Is Product RPPC Compliant in Target Market String IS_RIGID_PLASTIC_
PACKAGING

IS_RIGID_PLASTIC_
PACKAGING

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTradeItem
RigidPlasticPackagingContainer

Product RoHS Compliance Code String IS_ROHS_COMPLIANT IS_ROHS_COMPLIANT os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTrade
ItemROHSCompliant
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1WorldSync Attribute MDM Data
Type

Sync Profile Attribute Repository Attribute Xpath in 1WorldSync message

Is Product Considered Universal Waste? String IS_UNIVERSAL_WASTE IS_UNIVERSAL_WASTE os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTrade
ItemUniversalWaste

Can Product Be Easily Upgraded Or Maintained By
Consumer

String IS_UPGRADEABLE_OR_
MAINTAIN

IS_UPGRADEABLE_OR_
MAINTAIN

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/isTradeItem
ConsumerUpgradeableOr
Maintainable

Materials That Fail RoHS Compliance String ROHS_COMPL_FAILURE_
MATERIAL

ROHS_COMPL_FAILURE_
MATERIAL

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/rOHSCompliance
FailureMaterial

Link File Name String EXT_FILE_LINK_FILE_
NAME

EXT_FILE_LINK_FILE_
NAME

os:envelope/catalogueRequest/
document/item/targetMarket
Attributes/flex/attr[@name=
'externalFileLinkFileName']

MDM Operations for 1WorldSync Messages
The following is a list of 1WorldSync messages and corresponding operations selected by MDM for these messages.

Supplier Operations

1WorldSync message
type

Operation selected on Synchronization Profile Corresponding Operation and sub-operation selected in synchronization event

ITEM ADD Incremental Deliver To Operation Add: New

Yes Datapool Add

ITEM MODIFY/CORRECT Incremental Deliver To Operation

Yes/No Datapool Data Correction/

Cancel/ Discontinue/ Reinstate

ADD:CORRECT

Beside this ADD:CANCEL, ADD:DISCONTINUE and ADD:REINSTATE are also handled with this
message.

MDM Operations for 1WorldSync Messages (Supplier Operations)
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1WorldSync message
type

Operation selected on Synchronization Profile Corresponding Operation and sub-operation selected in synchronization event

LINK ADD Incremental Deliver To Operation LINK:NONE

Yes /No Datapool Add/ Data Correction

LINK DELETE Incremental Deliver To Operation LINK:UNLINK

Yes/No Datapool Add/ Data Correction

PUBLICATION ADD Incremental Deliver To Operation PUBLISH:NEW

PUBLISH:IMPLICIT

PUBLISH: RELOAD-COPY

PUBLISH: RELOAD-ORIGINAL

Yes /No Trading Partner on
Datapool

Add/ Publish

SubOperation for Add/Publish:

New

SubOperations Only applicable to Publish operation:

For RELOAD-COPY: Initial Load

For RELOAD-ORIGINAL- Initial Load+ Include Rejected
Records

Retailer Operations

Message Type Incoming/
  Outgoing

Description

1WorldSync Catalogue Item Notification (CIN) Incoming This new or initial or correction load message is received from Datapool when the supplier publishes the record for the retailer.

1WorldSync Catalogue Item Confirmation (CIC) Outgoing Catalog Item Confirmation message of the Received, Rejected, Review, and Synchronize type sent by the retailer in receipt of the CIN message
received.

For the steps to specify this message, refer Specifying Catalogue Item Confirmation Response.

1WorldSync Request For Catalogue Item Notification
(RFCIN)

Outgoing The RFCIN message sent by the retailer with isReload set as true/false.

For the steps to specify this message, refer to Specifying Request For Catalogue Item Notification Message.

1WorldSync Catalogue Item Notification Response (CINR) Outgoing This response message is sent by MDM in response to CIN.

1WorldSync Catalogue Item Confirmation Response Incoming The Catalog Item Confirmation response (CICR) received from Datapool in response to CIC messages.

MDM Operations for 1WorldSync Messages (Retailer Operations)
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Message Type Incoming/
  Outgoing

Description

1WorldSync Request For Catalogue Item Notification
Response

Incoming The Request For Catalog Item Notification Response (RFCINR) received from Datapool in response to RFCIN messages.
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Specifying Catalogue Item Confirmation Response

Procedure
1. Log in to the user’s enterprise with user credentials.

2. Click Browse and Search.

3. Select a repository and click View All.

4. Select the record for which the CIC message is to be specified.

5. On the View Record page, select Send Response.

6. Select the required Action.

l Review: Select the Confirmation Status Code and Corrective Action.

l Received: Select the Retailer Credential.

l Synchronised: Select the Retailer Credential.

l Rejected: Select the Confirmation Status Code and Corrective Action.

7. Click Submit.

Specifying Request For Catalogue Item Notification
Message

Procedure
1. Log in to the user’s enterprise with user credentials.

2. Click Browse and Search.

3. Select a repository and click View All.

4. Select the record for which message is to be specified.

5. On the View Record page, select Send Message.

6. Select the Action as RFCIN - Generate RFCIN Message.

7. Select the Datapool.
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8. Select Trading Partner.

Note: Verify the Company Credential and Trading Partner Credential
details.

9. Click Submit.

Correction Versus Modify
Based on GS1 Standards and Global Data Synchronization Network (GDSN) standards,
changes to some attributes require a new GTIN.

Information regarding the GS1 Standards is available at GS1 documentation site.

For these attributes, MDM generates a Correct message. For changes to all other attributes,
MDM generates a Modify message.

MDM sends Item correction for the following 1WorldSync attributes:

l Alternate Item Classification Code

l Alternate Item Classification Scheme

l Brand Name

l Brand Owner GLN

l Canceled Date

l Depth (if change > 20%)

l Depth UOM

l Discontinued Date

l EANUCC Code

l EANUCC Type

l Global Item Classification Code

l Gross Weight (if change > 20%)

l Gross Weight UOM

l Height (if change > 20%)

https://www.gs1.org/standards
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l Height UOM

l Net Content

l Net Content UOM

l Net Weight

l Net Weight UOM

l Product Type

l Qty of Next Level Item(s)

l Volume (if change > 20%)

l Volume UOM

l Width (if change > 20%)

l Width UOM

Supported 1WorldSync Responses
MDM supports the following 1WorldSync responses:

l Catalogue Response

ITEM MAINTENANCE CATALOGUE RESPONSE
ITEM LINK CATALOGUE RESPONSE
ITEM PUBLICATION CATALOGUE RESPONSE
MESSAGE EXCEPTION RESPONSE
1SYNC GDSN ITEM REGISTRY RESPONSE

l Item Synchronization Response

l Item Authorization Response

l 1SYNC Catalogue Item Notification (1SYNC CIN)

l 1SYNC Catalogue Item Notification Response (1SYNC CINR)

l 1SYNC Catalogue Item Confirmation (1SYNC CIC)

l 1SYNC Catalogue Item Confirmation Response (1SYNC CICR)

l 1SYNC Request For Catalogue Item Notification (1SYNC RFCIN)



ibi™ MDM Add-on for Global Data Synchronization User Guide

98 | Message Choreography

l 1SYNC Request For Catalogue Item Notification Response (1SYNC RFCINR)

Changing Message Choreography
You can use MDM to work with specific datapools.

Procedure
1. Update Rulebase to support New Message Type. For MDM to support a new message

type, the first step is to update the rbformatattributes_gdsn.xml rulebase file so
the new synchronization format is detected in the synchronization profile UI.

l Update the $MQ_COMMON_DIR/standard/rulebase/rbformatattributes_
gdsn.xml file.

2. Update Map file to support New Message Type. The next step is to update the map
file to support the new message type.

l Update the datapool specific map file from the $MQ_COMMON_DIR/standard/maps
folder.

l For more details on datapool specific map files for different message types,
refer to GDSN-Specific Maps.

3. Update Sync Operation Identifier Rulebase. Next, update the datapool specific sync
operation identifier rulebase to identify datapool specific sync operations.

l Update the appropriate file in: $MQ_COMMON_DIR/standard/rulebase.

l For 1WorldSync, the rulebase name is rbtransorasupplier.xml

4. Status Derivation. When a datapool receives a message from the MDM supplier or
retailer applications, a response is sent to the appropriate application. Based on the
response, MDM updates the status of the record. For example, if an "Item add"
message is sent, the record is internally updated based on the response received
from the datapool. You can update the status derivation.

l To add or to update an operation from the UI on the supplier or retailer
applications, change the constraints from the following file $MQ_COMMON_
DIR/standard/rulebase/rbsyncstatusupdatederivation.xml.

l To update from the UI, change the constraints in the $MQ_COMMON_
DIR/standard/rulebase/rbsyncstatusupdatederivation.xml update
statusderivation.xml file.
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l To update record status derivation on receiving a response from the datapool,
change the constraints in the $MQ_COMMON_
DIR/standard/rulebase/statusderivation.xml file.

5. Message Handler Selection. To change the message handler selection, properties
similar to the following should be updated in $MQ_HOME/config/gdsn.config

l com.tibco.cim.connector.plugin.mapping.handlemessaging.supplier.*1syn
c*=com.tibco.cim.init.connector.plugin.handlemessaging.supplier.1Sync

l com.tibco.cim.init.connector.plugin.handlemessaging.supplier.1Sync.cl
ass=com.tibco.mdm.gdsn.integration.connector.TransoraMessagingHandler

Configurable Components

Record Validation on UI

To enable record validation through the UI, depending on your datapool, copy the
appropriate rulebase from the standard rulebase folder to your enterprise specific
repository location:

File to copy For 1WorldSync: _1sync_mastercatalog_catalogvalidation.xml

Copy from $MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase

Copy to $MQ_COMMON_DIR/<ENTERPRISE_
INTERNALNAME>/catalog/master/<REPOSITORYID>

Rename it to catalogvalidation.xml.

Synchronization Profile Validation

Out-of-the-box catalog synchronization is provided through datapool specific rulebase files
which declare validation rules.

File to copy For 1WorldSync: _1Sync_catalogvalidation.xml

Copy from $MQ_HOME/plugins/gdsn/<version>/common/standard/rulebase

Copy to $MQ_COMMON_DIR/standard/rulebase
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Rulebase for Protocol Selection

This rulebase decides the protocol to be used by the messaging handler for outgoing
messages or the response handler for incoming messages.

$MQ_COMMON_DIR/standard/rulebase/rbconnectorprotocolderivation_gdsn.xml
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GDSN Impact onWorkflows and Rulebase
GDSN impacts the workflows and rulebase in ibi MDM.

l GDSN Impact on Rulebase

l GDSN Impact on Workflows

GDSN Impact on Rulebase

Modifying Business Process Rules

In the Rule List page, click the repository name to modify the rule. Use this page to modify
the existing conditions, actions, and defaults used in workflow processing. If a backend
system is part of the rule template, only Datapools associated with that backend system
are displayed.

SyncOperationAttribute

This function is used to find the operation date. The function gets the latest sync date for
the given Operation (only ADD is supported) from a Datapool or Trading Partner.

Syntax

<var>OPERATION_DATE</var>
<op func="SyncOperationAttribute">
<const type="string">ADD</const>
<const type="string">1Sync</const>
<!--const type="string">Trading Partner Name</const-->
</op>

For this function, three parameters can be specified.

The second parameter is the marketplace or datapool name. This is optional; if not
specified, the rulebase evaluates it.



ibi™ MDM Add-on for Global Data Synchronization User Guide

102 | GDSN Impact on Workflows and Rulebase

The third parameter is the trading partner name and is optional. If not specified, it looks
for all trading partners; if specified, it looks for the operation for the given trading partner.
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GDSN Impact on Workflows

GDSN Specific Workflows

The following table lists the various GDSN processes along with supported Document Type, Document Sub Type, Repository, and so on.

Document Type Document Sub
Type

Repository Sync
Profile

Default
Sender

Default
Receiver

Org Type Software
Edition

Doc Format Process Definition Name Default

Record Authorization
Notification

Any Any Any 1Sync Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Record
  Authorization
Notification

Any Any Any 1SyncTest Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Record  Publication
  Notification

Any Any Any 1Sync Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Record  Publication
  Request

Any Any Any 1Sync Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Record  Publication
  Notification

Any Any Any 1SyncTest Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Record  Publication
  Request

Any Any Any 1SyncTest Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Request for CIN
Notification

Any Any Any 1SyncTest Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Request for CIN
Notification

Any Any Any 1Sync Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Any Any Any Any Any Any Any Any cim2cim
document

wfoutveloselcin26v2.xml - CIN
Process for CIM2CIM

No

Request for CIN
Notification

Any Any Any Any Any Any Any Any wfin26rfcinv2.xml - Receive RFCIN
Process

No

RFCIN Notification Any Any Any Any Any Any Any Any wfin26catactionRFCINv2.xml - RFCIN
Retailer Process

No

GDSN Processes
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Document Type Document Sub
Type

Repository Sync
Profile

Default
Sender

Default
Receiver

Org Type Software
Edition

Doc Format Process Definition Name Default

Record  Publication
  Notification

Publication
Delivery
Notification

Any Any Any Any Any Any Any wfin26prodnotifv2.xml - Response
Notification process

No

Record  Publication
  Notification

Any Any Any Any Any Any Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Datapool
Response
Notification

Any Any Any Any Any Any Any wfin26prodnotifv2.xml - Response
Notification process

No

Record  Content
  Notification

Registry Response
Notification

Any Any Any Any Any Any Any wfin26prodnotifv2.xml - Response
Notification process

No

Record  Content
  Notification

Internal Error
Notification

Any Any Any Any Any Any Any wfin26prodnotifv2.xml - Response
Notification process

No

Record  Content
  Notification

Record Add
Notification

Any Any Any Any Retailer Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Data Change Any Any Any Any Retailer Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Delete Any Any Any Any Retailer Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Discontinue Any Any Any Any Retailer Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Cancel Any Any Any Any Retailer Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Data Correction Any Any Any Any Retailer Any Any wfin26prodnotifretailerv4.xml -
Record Notification process

No

Record  Content
  Notification

Record Add
Notification

Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml -
Record data notification Process

No

Record  Content
  Notification

Data Change Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml -
Record data notification Process

No

Record  Content
  Notification

Data Correction Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml -
Record data notification Process

No
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Document Type Document Sub
Type

Repository Sync
Profile

Default
Sender

Default
Receiver

Org Type Software
Edition

Doc Format Process Definition Name Default

Record  Content
  Notification

Delete Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml -
Record data notification Process

No

Record  Content
  Notification

Cancel Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml -
Record data notification Process

No

Record  Content
  Notification

Discontinue Any Any Any Any Any Any Any wfin26prodnotifprocessv2.xml -
Record data notification Process

No

Record
  Authorization
  Notification

Any Any Any Any Any Any Any Any wfin26prodnotifbasicv3.xml -
Incoming Message processing
Process

No

Purge Historical Data Any Any Any Any Any Any Any Any wfin26purgev3.xml - Purge process No

Any Any Any Any Any Any Any Any Any wfoutagentrics50cin26v2.xml -
Agentrics CIN Process

No

Any Any Any Any 1SyncTest Any Retailer Any 1Sync
document

wfout1sync65cin26v1.xml - 1Sync
CIN process

No

Any Any Any Any 1Sync Any Retailer Any 1Sync
document

wfout1sync65cin26v1.xml - 1Sync
CIN process

No

Any Any Any Any 1SyncTest Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No

Any Any Any Any 1Sync Any Any Any Any wfout1sync62cic26v1.xml - 1sync CIC
Process

No
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Setting up CIM to CIM
Two MDM applications can be connected. The full setup for testing the CIM to CIM
Synchronization capability is mentioned later. As an administrator, you can connect and
synchronize two MDM environments.

Need for Synchronization
ibi MDM supports organizations to communicate with trading partners through datapools.
For example, a supplier can do business with a trading partner through a datapool like
1WorldSync.

However, an organization may sometimes want to communicate privately with its trading
partners without a third party datapool. Also, companies in different locations may need to
internally synchronize data in their systems, involving datapools.

In such cases, organizations can deploy instances of CIM per location and synchronize as
required. To do this, TIBCO provides an out-of-the-box functionality to connect and sync
two or more CIM instances. Instances from different entities can communicate with each
other directly, without involving a third party datapool.

Types of Synchronization

Synchronization can occur between any of the two types:

l Two or more enterprises on a single ibi MDM instance

l Two different ibi MDM instances

How it Works

Process in which four different enterprises are created on a single CIM instance.

l BrandOwner, VeloselMarketPlace, Bottler1, and Bottler2 are four enterprises
created.

l BrandOwner is the main enterprise of type Supplier. The BrandOwner subscribes to
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the VeloselMarketplace enterprise (to which it synchronizes all updates). It has
Bottler1 and Bottler2 as trading partners.

l VeloselMarketplace is an enterprise of type Marketplace. Consider this as the central
location to which data is synchronized and from where updates are received (by the
subscribed suppliers). It has BrandOwner, Bottler1 and Bottler2 as trading
partners.

l Bottler1 and Bottler2 are enterprises of type Supplier. They are both subscribed to
the VeloselMarketplace enterprise (to receive BrandOwner’s updates) and have
BrandOwner as a trading partner.

In the scenario, whenever Brandowner has information to synchronize, for example a
record, it is synchronized to VeloselMarketplace, from where Bottler1 and Bottler2
receive the update (record) because of their subscription.

Note: You can synchronize by creating a special enterprise of type 'Marketplace'
with the name as VeloselMarketplace. The name of the enterprise has to be
VeloselMarketplace for the application to work as provided out-of-thebox.
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Synchronizing Two CIM Instances
The following steps are involved in synchronizing two CIM instances. Each step is explained
in detail in the following sections.

Procedure
1. Setting up Queue Configuration

Make the required queue configuration changes.

2. Creating Enterprise and Prepopulating Data
Run the required database scripts.

3. Configuring Database Changes
Run the application server. Create three or more enterprises. Populate the
enterprises with data by running XML packs.

4. Company Profile and GLN credentials
Create company profiles and GLN credentials for each enterprise.

5. Trading Partner Profile
Define trading partners for each enterprise and input GLNs.

6. Changing Rulebase
Make the required rulebase changes.

7. Datasource and Input Map for BrandOwner
Create Datasource and InputMap for BrandOwner enterprise.

8. Processing Reverse Relationships (Optional Step)
  Only required if you need reverse relationships processed.

9. Testing your CIM to CIM Setup
Test your setup.
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Setting up Queue Configuration

Before you begin
If you are in the process of synchronizing 1WorldSync datapool, do not follow the steps
listed here for queue setup; instead use the out-of-the-box queue configuration.

Procedure
1. Queue Setup for CIM to CIM Integration Messages:

l For communication between two enterprises, you need gateways to transport
messages across two firewalls and from the Q_ECM_INTGR_STD_OUTBOUND_
INTGR_MSG queue of the sender instance to Q_ECM_INTGR_STD_INBOUND_
INTGR_MSG queue of the receiver instance. These gateways cannot be used for
testing, but a simple trick can be used to simulate it.

l Because the messaging framework helps in mapping the logical and physical
queue names and supports connectivity to multiple JMS servers from the same
instance, you can use the Q_ECM_INTGR_STD_INBOUND_INTGR_MSG physical
queue hosted on one of the JMS servers (the one connected to
VeloselMarketplace) and map it to:

o the StandardOutboundIntgrMsg logical queue used to send outbound
integration messages from the BrandOwner instance.

o the StandardInboundIntgrMsg logical queue used to receive inbound
integration messages in the VeloselMarketplace instance.

2. The following changes need to be done in ConfigValues.xml. To connect to two
different queue managers, BrandOwner will need two different clusters. If
BrandOwner uses TIBCO EMS, add the following lines to ConfigValues.xml after the
TIBCO Messaging Cluster section.

l Change 1, search for <Category name="TIBCO EMS" visibility="Advanced">.
  Add the following lines:

<!- V2V ENTRIES ->
<ConfValue
description="com.tibco.cim.queue.cluster.TIBCOCluster2 - added
for v2v" name="com.tibco.cim.queue.cluster.TIBCOCluster2"
propname="com.tibco.cim.queue.cluster.TIBCOCluster2"
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readonly="false" sinceVersion="7.1" visibility="Basic">
<ConfString

default="inherit:com.tibco.cim.queue.cluster.DefCluster"
  value="inherit:com.tibco.cim.queue.cluster.DefCluster"/>
</ConfValue>
<ConfValue
description="com.tibco.cim.queue.cluster.TIBCOCluster2.cluster
Liaison.class - added for v2v"
name="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison
.class"
propname="com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLia
ison.class" readonly="false" sinceVersion="7.1"
visibility="Basic">

<ConfString default =
  "com.tibco.mdm.integration.messaging.queue.tibco.TIBCOCluste
rLiaison"   value =
  "com.tibco.mdm.integration.messaging.queue.tibco.TIBCOCluste
rLiaison"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defUser - added for
v2v" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defUser" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defUser" readonly =
"false" sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "admin" value = "admin"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword - added
for v2v" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword"
propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defPassword"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "" value = ""/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID - added
for v2v" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID"
propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.defClientID"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">



ibi™ MDM Add-on for Global Data Synchronization User Guide

111 | Synchronizing Two CIM Instances

<ConfString default = "null" value = "null"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServers" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServers" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServers" readonly = "false" sinceVersion = "7.1"
visibility = "Basic">

<ConfString default = "LocalhostServer" value =
"LocalhostServer"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServer.LocalhostServer" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServer.LocalhostServer" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServer.LocalhostServer" readonly = "false" sinceVersion =
"7.1" visibility = "Basic">

<ConfString default = "tcp://localhost:7222" value =
"tcp://localhost:7222"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServer.encoding.LocalhostServer - added for v2v" name =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServer.encoding.LocalhostServer" propname =
"com.tibco.cim.queue.cluster.TIBCOCluster2.clusterLiaison.clus
teredServer.encoding.LocalhostServer" readonly = "false"
sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "UTF-8" value = "UTF-8"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster -
added for v2v" name =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster"
propname =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "TIBCOCluster2" value =
"TIBCOCluster2"/>
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</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJNDI
- added for v2v" name =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJNDI"
propname =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.addToJNDI"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

<ConfBool default = "false" value = "false"/>
</ConfValue>
<ConfValue description =
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster -
added for v2v" name =
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster"
propname =
"com.tibco.cim.queue.queue.StandardInboundIntgrMsg.cluster"
readonly = "false" sinceVersion = "7.1" visibility = "Basic">

<ConfString default = "TIBCOCluster2" value =
"TIBCOCluster2"/>
</ConfValue>

l Change 2, search for <Category name="StandardOutboundIntgrMsg"
visibility="Advanced">. Add the following lines:

<!- V2V ENTRIES ->
<ConfValue description = "" isHotDeployable = "false" name =
"EMS Queue Name" propname =
"com.tibco.cim.queue.queue.StandardOutboundIntgrMsg.cluster.TI
BCOCluster2.queue" sinceVersion = "7.0" visibility =
"Advanced">

<ConfString default = "Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG"
   value =   "Q_ECM_INTGR_STD_OUTBOUND_INTGR_MSG"/>
</ConfValue>

l Change 3, search for <Category name="StandardInboundIntgrMsg"
visibility="Advanced">. Add the following lines:

<!- V2V ENTRIES ->
<ConfValue description="" isHotDeployable="false" name="EMS
Queue  Name"
 propname="com.tibco.cim.queue.queue.StandardInboundIntgrMsg.c
lust er.TIBCOCluster2.queue" sinceVersion="7.0"
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visibility="Advanced">
<ConfString default="Q_ECM_INTGR_STD_ OUTBOUND _INTGR_MSG"

   value="Q_ECM_INTGR_STD_ OUTBOUND_INTGR_MSG"/>
</ConfValue>

Creating Enterprise and Prepopulating Data

Before you begin
Ensure that the Application Server is running.

Procedure
1. Create four or more enterprises.

Enterprise Type

BrandOwner Supplier

VeloselMarketplace Marketplace

Bottler1 Supplier

Bottler2 Supplier

2. Create BrandOwner Enterprise:

l Create a BrandOwner Enterprise of type Supplier with Internal Name as
bowner

Attribute Value

Enterprise BrandOwner

Enterprise Type Supplier

Internal Name bowner
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l Create a user admin with first name admin and last name admin. Assign the
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin

First/Middle/Last admin//admin

Roles Work Supervisor/Admin

l Import XML Pack for BrandOwner Enterprise, you can import an XML pack to
prepopulate the enterprise with some data.

o Log in to the BrandOwner enterprise.

o Select System Operations > Import Metadata.

o Provide the path to the following xml file: $MQ_COMMON_
DIR/common/standard/samples/cim2cimmetadata/Brandowner/BrandOwn
er-MetaData.jar.

o Refer to Step 6 to view the data generated through XML pack import.

3. Create VeloselMarketplace Enterprise (This is just for subscription purposes. The real
Velosel Marketplace Enterprise resides on Instance 2):

l Create an Enterprise VeloselMarketplace of type Marketplace with Internal
Name as Veloselm.
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Attribute Value

Enterprise VeloselMarketplace

Enterprise Type Marketplace

Internal Name Veloselm

l Create a user admin with first name admin and last name user.   Assign the
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin

First/Middle/Last admin//admin

Roles Work Supervisor/Admin

l Import XML Pack for VeloselMarketplace Enterprise, you can import an XML
pack to prepopulate the enterprise with some data.

o Log in to the VeloselMarketplace enterprise.

o Select System Operations > Import Meta Data.

o Provide the path to the following xml file: $MQ_COMMON_
DIR/standard/samples/cim2cimmetadata/VeloselMarketplace/Velosel
Marketplace-MetaData.jar

o Refer to Step 6 to view the data generated through XML pack import.

4. Create Bottler1 Enterprise:

l Create an Enterprise Bottler1 of type Supplier with Internal Name as Bottler1.

Attribute Value

Enterprise Bottler1
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Attribute Value

Enterprise Type Supplier

Internal Name Bottler1

l Create a user admin with first name admin and last name user. Assign the
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin

First/Middle/Last admin//admin

Roles Work Supervisor/Admin

l Import XML Pack for Bottler1 Enterprise, you can import an XML pack to
prepopulate the enterprise with some data.

o Log in to the Bottler1 enterprise.

o Select System Operations > Import Meta Data.

o Provide the path to the following xml file: $MQ_COMMON_
DIR/standard/samples/cim2cimmetadata/Bottler1/Bottler1-
MetaData.jar.

o Refer to Step 6 to view the data generated through XML pack import.

5. Create Bottler2 Enterprise:

l Create an Enterprise Bottler2 of type Supplier with Internal Name as Bottler2

Attribute Value

Enterprise Bottler2

Enterprise Name Supplier

Internal Name Bottler2
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l Create a user admin with first name admin and last name user. Assign the
Work Supervisor and Admin roles to this user.

Attribute Value

User Name admin

First/Middle/Last admin//admin

Roles Work Supervisor/Admin

l Import XML Pack for Bottler2 Enterprise, you can import an XML pack to
prepopulate the enterprise with some data.

o Log in to the Bottler2 enterprise.

o Select System Operations > Import Meta Data.

o Provide the path to the following XML file: $MQ_COMMON_
DIR/standard/samples/cim2cimmetadata/Bottler2/Bottler2-
MetaData.ja

o Refer to Step 6 to view the data generated through XML pack import.

6. Data generated through XML Pack Import: By importing the various XML packs, the
respective enterprises are populated with the following: Repository: For example,
MC_V2VITEMMASTER

Attributes: some custom attributes in repository MC_V2VITEMMASTER

Output Maps: an output map OM_V2VOUTPUT based on the EANUCCExt Output
format created in repository MC_V2VITEMMASTER
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Synchronization Format: EANUCCEXT synchronization format with some custom
attributes

The following Business Process rules are created:

l Brandowner enterprise: Custom Protocol Selection and Rulebase Selection

l VeloselMarketplace enterprise: Custom Protocol Selection, Rulebase Selection,
and Repository Selection for Received Records

l Bottler1 and Bottler2 enterprises: Custom Protocol Selection and Repository
Selection for Received Records

Configuring Database Changes

Procedure
1. Navigate to the database.

2. Run the following scripts from the database.
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Result

Note: Use the OrgID of your organization and replace it in the SQL below where
it displays <Org ID Here>.

l Bottler Subscription Rulebase

insert into ConfigurationDefinition (ID, TYPE, OWNERID, GLOBAL,
NAME, SELECTOR, DESCRIPTION, DEFINITIONTYPE, DEFINITION, ACTIVE,
MODMEMBERID, MODDATE, MODVERSION)
VALUES (Mq_Sequence_1.nextval, 'Rulebase', <Brandowner's Org ID
Here>, 'N', 'Bottler Subscription', ‘SUBSCRIPTION’, 'Select
Subscription.', 'File',
'bottler/rulebase/rbsynchtradingpartner.xml', 'Y', 1, SYSDATE, 1);
COMMIT;

l BrandOwner Translation Map

insert into ConfigurationDefinition
(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION,
DEFINITIONTYPE, DEFINITION,
ACTIVE, MODMEMBERID, MODDATE, MODVERSION)

VALUES (Mq_Sequence_1.nextval, 'XSLT', <Brandowner's Org ID Here>,
'N', 'Custom Map', 'CONNECTOR',
'Message Translation.', 'File',
'standard/maps/mpfromcatact26toveloselcinv1.xsl', 'Y', 1, SYSDATE,
1);
COMMIT;

l VeloselMarketplace Translation Map

insert into ConfigurationDefinition
(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION,
DEFINITIONTYPE, DEFINITION,
ACTIVE, MODMEMBERID, MODDATE, MODVERSION)
VALUES (Mq_Sequence_1.nextval, 'XSLT', <VeloselMarketplace's Org ID
Here>, 'N', 'Custom Map', 'CONNECTOR', 'Message Translation.',
'File', 'standard/maps/mpfromcatact26toveloselcinv1.xsl', 'Y', 1,
SYSDATE, 1);
COMMIT;
insert into ConfigurationDefinition
(ID, TYPE, OWNERID, GLOBAL, NAME, SELECTOR, DESCRIPTION,
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DEFINITIONTYPE, DEFINITION,
ACTIVE, MODMEMBERID, MODDATE, MODVERSION)

VALUES (Mq_Sequence_1.nextval, 'XSLT', <VeloselMarketplace's Org ID
Here>, 'N', 'Custom Map', 'CONNECTOR',
'Message Translation to create Response.', 'File',
'standard/maps/mpfromveloselcintoveloselcinrv1.xsl', 'Y', 1,
SYSDATE, 1);
COMMIT;

l VeloselMarketplace Subscription Rulebase

insert into ConfigurationDefinition (ID, TYPE, OWNERID, GLOBAL,
NAME, SELECTOR, DESCRIPTION, DEFINITIONTYPE, DEFINITION, ACTIVE,
MODMEMBERID, MODDATE, MODVERSION) VALUES (mq_sequence_1. nextval,
'Rulebase', <VeloselMarketplace's Org ID Here>, 'N', 'Bottler
Subscription', 'SUBSCRIPTION', 'Select Subscription.', 'File',
'bottler/rulebase/rbsynchveloselmarketplace.xml', 'Y', 1, SYSDATE,
1)
COMMIT;

l VeloselMarketplace Translation Maps (Instance 2)

o XSL Map for translating CIM CIN to mlXML:   mpfromveloseltomlxml26v1.xsl

o XSL Map for translating CIM CIN to CIM CIN Response:
mpfromveloselcintoveloselcinrv1.xsl

Note: For simplicity, you can make all the above Subscription Rulebase and
Translation Map files globally available as follows:

l Enter a value '1' instead of <Brandowner's OR VeloselMarketplace's Org ID
Here> for column OWNERID

l Enter a value 'Y' instead of 'N' for column GLOBAL.

Company Profile and GLN credentials
Create GLN credentials for each enterprise. These credentials are used to uniquely identify
the enterprise to communicate with.
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Creating GLN for BrandOwner Enterprise
1. Log in to the BrandOwner enterprise.

2. Subscribe to VeloselMarketplace.

1. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

2. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile called BrandOwner and create a GLN for it.

1. Select Administration > My > Company Profile.

2. Create a valid credential by clicking the Create link in the Credential section.

3. On the Create Credential page, provide Domain as GLN and ID as <GLN> and
click Save.

Creating GLN for VeloselMarketplace Enterprise

Procedure
1. Log in to the VeloselMarketplace enterprise.

2. Subscribe to VeloselMarketplace.
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a. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile VeloselMarketplace and create a GLN for it.

a. Select Administration > Company Profile

b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential page, provide Domain as GLN and ID as <GLN>. Click
Save.

Creating GLN for Bottler1 Enterprise

Procedure
1. Log in to the Bottler1 enterprise.

2. Subscribe to VeloselMarketplace

a. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile called Bottler1 and create a GLN for it.

a. Select Administration > Company Profile.

b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential page, provide Domain as GLN and ID as <GLN>. Click
Save.

Creating GLN for Bottler2 Enterprise

Procedure
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1. Log in to the Bottler2 enterprise.

2. Subscribe to VeloselMarketplace

a. Select Administration > Datapool Profiles and click Subscribe (in the Actions
column) against VeloselMarketplace.

b. Click Modify against VeloselMarketplace, click Modify in the Supported
Synchronization Formats section and select the EANUCC synchronization
format. Click Save.

3. Create a Company Profile called Bottler2 and create a GLN for it.

a. Select Administration > Company Profile.

b. Create a valid GLN by clicking the Create link in the Credential section.

c. On the Create Credential page, provide Domain as GLN and ID as <GLN>. Click
Save.

Trading Partner Profile
Define trading partners for each enterprise and provide the GLN credentials of those
trading partners.

Note: The GLN credentials provided here for trading partners should be the
same ones defined in Company Profile and GLN credentials for each enterprise.

Creating Trading Partner Profile for BrandOwner
Enterprise

Procedure
1. Log in to the BrandOwner enterprise and define Bottler1 and Bottler2 as trading

partners.

2. Create a Trading Partner Profile: Bottler1.

a. Select Administration > Trading Partner Profiles.
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b. Create a Trading Partner with name as Bottler1; select VeloselMarketplace
under the Datapool section; select the EANUCCEXT Synchronization format.
Click Save.

c. Once the Bottler1 Trading Partner Profile is created, click Bottler1 in the
Trading Partner Profiles List.

d. Click Extended Credentials against VeloselMarketplace in the Datapool
Participation section.

e. Click Create to create a Credential for Bottler1.

f. Select Domain as GLN, and provide the <GLN as the Identity. Click Save. The
GLN you provide here should be the one defined in Creating GLN for Bottler1
Enterprise.

3. Follow the same steps to create a Trading Partner Profile: Bottler2 and provide
extended credentials listing the GLN.

Creating Trading Partner Profile for
VeloselMarketplace Enterprise

Procedure
1. Log in to the VeloselMarketplace enterprise and define BrandOwner, Bottler1 and

Bottler2 as trading partners.

2. Create a Trading Partner Profile: BrandOwner.

a. Select Administration > Trading Partner Profiles.

b. Create a Trading Partner with the name BrandOwner; From the Datapool
section, select VeloselMarketplace. Now select the EANUCCEXT
Synchronization format. Click Save.

c. After you create the BrandOwner Trading Partner Profile, click BrandOwner in
the Trading Partner Profiles List.

d. Click Extended Credentials against VeloselMarketplace in the Datapool
Participation section.

e. Click Create to create a Credential for BrandOwner.

f. Select Domain as GLN, and provide the <GLN as the Identity. Click Save. The
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GLD you provide here should be the one defined in Creating GLN for Bottler1
Enterprise.

3. Follow the same steps to define Bottler1 and Bottler2 as trading partners and
provide extended credentials listing their respective GLN IDs.

Creating Trading Partner Profile for Bottler1 and
Bottler2

Procedure
1. Log in to the Bottler1 and Bottler2 enterprises respectively and define BrandOwner

as a trading partner for each.

2. Provide extended credentials listing the BrandOwner GLN.

Changing Rulebase
You need to make some changes to the rbsynchtradingpartner.xml rulebase file through
which marketplaces and trading partners are specified.

Procedure
1. In $MQ_COMMON_DIR/bottler/rulebase, open the rbsynchtradingpartner.xml

rulebase file.

2. Make the following changes in this file for variable declaration.

l Declare Variables for Enterprises

o Search for the following section:
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<!-- Convenience variables to hold GLN number to use. -->

o Provide the following as the first four variable declarations:
BO_GLN, VM_GLN, TP1GLN, TP2GLN.

o Your code should read as follows:

<declare usage="local">
<var>BO_GLN</var>

</declare>
<declare usage="local">

<var>VM_GLN</var>
</declare>
<declare usage="local">

<var>TP1GLN</var>
</declare>
<declare usage="local">

<var>TP2GLN</var>
</declare>

l Assign Credential Variables and Values

o Search for the following section:
<name>AssignCredentials</name>

o Provide the appropriate GLN variables (BO_GLN, VM_GLN, TP1GLN,
TP2GLN) and the GLNs. Ensure that the GLNs match what you have
defined in the UI.

o Your code should read as follows:

<action>
<assign>

<var>BO_GLN</var>
<const type="string">0044444447786</const>

</assign>
<assign>

<var>VM_GLN</var>
<const type="string">0044444447779</const>

</assign>
<assign>

<var>TP1GLN</var>
<const type="string">0044444447793</const>
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</assign>
<assign>

<var>TP2GLN</var>
<const type="string">0044444447700</const>

</assign>
</action>

l Define Marketplaces for each Product

o Search for: <description>Marketplaces for Each
Products</description>

o Search for the following variable: <var>SenderArray</var>

o Assign the following variables to SenderArray: <var>BO_GLN</var>
  <var>BO_GLN</var>

o Search for the following variable: <var>ChannelArray</var>

o Assign the following variables to ChannelArray: <var>VM_GLN</var>
  <var>VM_GLN</var>

o Search for the following variable: <var>TradingPartnerArray</var>

o Assign the following variables to TradingPartnerArray:
<var>TP1GLN</var>   <var>TP2GLN</var>

Note: Two variables are added to the Sender Array and
Channel Array sections respectively, for two trading partners.
You need as many variables in these sections as trading
partners.

Datasource and Input Map for BrandOwner
Create a datasource and input map for the BrandOwner enterprise.

Creating Datasource

Procedure
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1. Log in to the BrandOwner enterprise.

2. Select Item Data > Data Sources

a. Create Datasource DS_V2VItems.

b. Provide some data as input to the datasource.

Creating Inputmap

Procedure
1. Create an input map between the DS_V2VItems datasource and the MC_

V2VItemMaster repository.

2. Select Item Data > Repositories

a. Select the check box against the MC_V2VITEMMASTER repository and click the
Manage Input Maps button.

b. Click Create to create a new input map.

c. On the Create Input Map page:

d. Provide an Input Map Name and Input Map Description. Select Split/Approval
Required.

e. Select DS_V2VItems check box and click Next.

f. Map the required attributes. The following are required:

l Record ID

l Record ID Extension

l Related Records

l SupplierID

l GTIN
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l Brand_Owner_ID

l Brand_Owner_ID

l Content_Owner_IDContent_Owner_ID

l Name_Of_Brand_Owner

l Name_of_Datapool

l Name_Of_Info_Provider

l Source_Data_Pool_ID

l Target_Market_ID

g. Click Save.

Processing Reverse Relationships (Optional
Step)
By default, the workflows are set up to process forward relationships (for example: A
contains B, B contains C, C contains D).

In case you have reverse relationship hierarchies (for example, A contained by B, B
contained by C, and so on), you need to make some changes to process reverse
relationships so that data is propagated correctly from BrandOwner to Marketplace and
Bottlers.

Procedure
1. Change to the wfin26cim2cimsyncV1.xml Workflow. You can use this workflow for CIM

to CIM synchronization.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26cim2cimsyncV1.xml file.
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Search for the following section:  <!-- Sample transition to
flip the root of bundles -->    <!-- Transition
   FromActivity="HandleRecordCollectionForFlipDecision"
   ToActivity="ManageRecordCollectionForFlip">
       <Description>If the Rulebase Selection Business Process
Rule      is set, only then transition to ApplySynchRuleBase
and Spawn      Publish Workflow</Description>         <Rule>
           <Parameter name="Rulebase" type="string"
eval="rule"          source="Rulebase Selection"
         direction="in">inDoc</Parameter>

<Parameter name="result" type="boolean"
direction="out"/>

<Condition format="bsh"><![CDATA[
result = (Rulebase != null &&

!Rulebase.equals(""));
</Condition>

</Rule>
</Transition>
<Transition FromActivity="ManageRecordCollectionForFlip"

ToActivity="ApplySynchRuleBase"/
-->

b. Uncomment this section (commented out by default) to process reverse
relationships.

2. Change to the wfin26catsourceimportv2.xml Workflow. You can use this workflow for
import/load and import events.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26catsourceimportv2.xml
file.

b. Search for:  <Activity Name="ManageRecordCollection">

c. Search for the RelationshipName parameter:  <Parameter direction="in"
name="RelationshipName" type="string"
eval="constant">Contains</Parameter>

d. Change this from Contains to ContainedBy to process reverse relationships.

3. Change to the wfin26catsourcev5.xml Workflow. You can use this workflow for
datasource loads and import of records.

a. Open the $MQ_COMMON_DIR/standard/workflow/wfin26catsourcev5.xml file.

b. Search for:  <Activity Name="ManageRecordCollection">
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c. Search for the RelationshipName parameter:  <Parameter direction="in"
name="RelationshipName" type="string"
eval="constant">Contains</Parameter>

d. Change this from Contains to ContainedBy to process reverse relationships.

4. Change to the wfin26prodnotifprocessv2.xml Workflow. You can use this workflow to
process the incoming record messages and to save data.

a. Open the $MQ_COMMON_
DIR/standard/workflow/wfin26prodnotifprocessv2.xml file.

b. Search for the following activities:

l <Activity Name="GetProductInfo">

l <Activity Name="GetProductInfo2">

c. Add the following parameter:
<Parameter direction="in" name="RelationshipName" type="string"
eval="constant">Contains</Parameter>.

Testing your CIM to CIM Setup
After completing all the outlined steps, you can test your CIM to CIM setup.

Procedure
1. Log in to the BrandOwner enterprise and add a record.

2. This record is synchronized to VeloselMarketPlace and to Bottler1 and Bottler2.

3. You can login to VeloselMarketPlace, Bottler1, and Bottler2 to verify the
synchronization.
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Troubleshooting CIM to CIM
Issue Solution

In a CIM to CIM setup, when attempting to import
over 100 records, you may get a "No data to read
from socket" error. DB Error code: 17410.

This problem may be seen if you are on an
Oracle 11 version lower than 11.1.0.7 (for
example, 11.1.0.6). Try updating to 11.1.0.7.
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Supplier and Retailer Setups
You can use Supplier and Retailer side setups to create Supplier and Retailer Enterprise in
ibi MDM.

Supplier Setup
You can use this setup to create and define an enterprise.

You can also select and define a repository for messages.

Creating Supplier Enterprise

Procedure
1. Log in to the tibcocim enterprise with superuser credentials.

2. Select Administration > All Company > Profiles.

a. Click Create and create a new Profile with Type as Supplier.

b. Create a user for the enterprise with Administrator and Work Supervisor
Roles.

3. Log out of the enterprise.

Defining Supplier Enterprise
You can define credentials, subscribe to the datapool, define the Synchronization Format,
and set up trading partners. 1Sync is used as an example here.

Procedure
1. Log in to the newly created enterprise with the created user credentials.
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2. Select Administration > My Company Profile.

a. Click the Create link in the Credentials section.

b. Create a Credential with Domain as GLN and provide your Supplier GLN as the
Identity.

3. Select Administration > Datapool Profiles.

a. Subscribe to 1Sync by clicking the Subscribe link in the Actions column.

b. Click Modify in the Actions column.

c. Click Modify again under Supported Synchronization Formats.

d. Select 1Sync from the list of Synchronization Formats. Click Save.

4. Select Administration > Trading Partner Profiles.

a. Click Create to create a new Trading Partner.

b. Provide details to create the Trading Partner and select 1Sync as the Default
Synchronization Format. Click Save.

c. In newly created Trading Partner Profiles, click on Modify.

d. Select 1Sync as the Datapool. Click Save.

e. Click the newly created trading partner in the trading partner list.

f. Click the Extended Credentials link against the 1Sync in the Datapool
Participation section.

g. Click Create to create a credential.

h. Select Domain as GLN and provide the GLN of the trading partner as the
Identity.

i. Click Save.

5. Select Administration > My Company Profiles.

a. Click the Credentials link against 1Sync in the Datapool Participation section.

b. Click Create to create a credential.

c. Select Domain as GLN. The Supplier GLN is populated in the Identity drop-
down list.

d. Specify the Batch User ID, User ID, and Password for the Supplier GLN.



ibi™ MDM Add-on for Global Data Synchronization User Guide

135 | Supplier and Retailer Setups

e. Click Save.

Note: ibi MDM supports more than one GLN in an enterprise. You can create
more than one GLN in an enterprise.

Defining Repository for Outgoing Messages
You can create or define the repository that messages will go out from.

Procedure
1. Deploy repository model from ibi MDM Studio containing the 1Sync output map and

UDEX and GPC classification schemes.
For more information about creating repositories, see ibi MDM Studio Repository
User’s Guide.

2. (Optional step) Perform this step to use out-of-the-box catalog validation file of ibi
MDM. The file contains some predefined validations associated with datapool
validations.

a. Navigate to $MQ_COMMON_DIR/standard/rulebase.

b. Copy the _1sync_mastercatalog_catalogvalidation.xml rulebase file and
place it into the $MQ_COMMON_DIR/enterprise/catalog/master/repositoryID
folder.

c. Rename the file as catalogvalidation.xml.

Selecting Repository for Incoming Messages
You can select the repository to which messages from the retailer side should be directed.

Procedure
1. Log in with the Supplier credentials.

2. Create a Business Process Rule to select the repository for the Add Notification event.
To create a Business Process Rule, follow these steps:

a. Click Business Processes, then click the Repository Selection rule.
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b. Click the Default business process template and click Create.

c. Select Conditions > the trading partner name is, and then select your trading
partner (specify the trading partner name only if you want messages from
different trading partners to be added to partner specific repositories).

d. Select Conditions > The UDEX Code is, and then select your defined UDEX
code or select Any.

e. Select Actions > The repository to add the record to, and then select your
repository.

f. Select Actions > Treat new CINs as ’data change’ messages, and then select
Yes, consider it as changes.

g. Click Save.

Retailer Setup
You can use this setup to create and define an enterprise.

You can also select repository, approvers, and editors for records.

Creating the Retailer Enterprise

Procedure
1. Log in to the tibcocim enterprise with superuser credentials.

2. Select Administration > All Company Profiles.

a. Click Create and create a new Profile with Type as Retailer.

b. Create a user for that enterprise with Administrator and Work Supervisor
Roles.

3. Log out of the enterprise.

Define the Retailer Enterprise
The Retailer side setup is similar to the Supplier setup. See Supplier Setup.
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The only difference is the GLN definition. For example:

Case 1

If the Supplier and Retailer is TIBCOCIM, then on the Retailer side, follow these steps:

l When defining the GLN in the Company Profile, provide the Trading Partner GLN of
the Supplier.

l When defining the Trading partner GLN, provide the Supplier GLN defined in the
Company Profile.

Case 2

If the Supplier is not TIBCOCIM, then on the Retailer side, follow these steps:

l Define the GLN of the Retailer in the Company Profile.

l Define the Supplier GLN in the Trading Partner’s GLN.

Note: ibi MDM supports more than one GLN in an enterprise. You can create
more than one GLN in an enterprise.

Selecting Repository for Incoming Messages
You can select the repository to which messages from the supplier side should be directed.

Procedure
1. Log in with the Retailer credentials.

2. Create a Business Process Rule to select the repository for the Add Notification event.
To create a Business Process Rule, follow these steps:

a. Click Business Processes, then click the Repository Selection rule.

b. Click the Default business process template and click Create.

c. Select Conditions > the trading partner name is, and then select your trading
partner (specify the trading partner name only if you want messages from
different trading partners to be added to partner specific repositories).
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d. Select Conditions > The UDEX Code is, and then select your defined UDEX
code or select Any.

e. Select Actions > The repository to add the record to, and then select your
repository.

f. Select Actions > Treat new CINs as ’data change’ messages, and then select
Yes, consider it as changes.

g. Click Save.

Selecting Approvers for Received Records
You can set up a rule for approvers of received records.

Procedure
1. Click Business Processes, then click the Approvers for Received Records rule.

2. Click the Default Business Process Template. Click Create to create a new rule.

3. Under Conditions > the trading partner name is, and then select the defined
trading partner.

4. Select Actions > Set the participant user to, and then provide the user
information.

5. Select Actions > Set the next work item state to, and the define the next state of
the workitem. For example, you can set the workitem state to Final Step.

6. Click Save.

Selecting Editors for Received Records
You can set up a rule for editors of received records.

Procedure
1. Click Business Processes, then click the Editors for Received Records rule.

2. Click the Default Business Process Template. Click Create to create a new rule.

3. Select Conditions > the trading partner name is, and then select the defined
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trading partner.

4. Select Actions > Set the participant user to, and then provide the user information.

5. Select Actions > Set the next work item state to, and then define the next state of
the workitem. For example, you can set the workitem state to Final Step/Done.

6. Click Save.

Detecting New Backend Systems
You can set up a rule to define the user or role to notify when a new backend system is
detected.

Procedure
1. Click Business Processes, then click Unknown Trading Partner Alert.

2. Click the Default Business Process Template. Click Create to create a new rule.

3. Select Actions > Set the participant user to, and then provide the user information.

4. Click Save.
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Setting up GPC Classification Scheme Data
Load
Setting up the data load for the Global Product Classification scheme includes configuring
GPC Classification Scheme Loading and configuring Support for GPC Code.

Configuring GPC Classification Scheme Loading
The GPC data source is provided as out-of-the-box set up in the TIBCOCIM enterprise.

You can upload new GPC codes into CIM.

Procedure
1. Add the following dataset to the filewatcher.xml catalog.

<DataSet type="single">
<!--
There should be no MasterCatalog Element when importing a Standard
Classification Scheme such as GPC, UDEX.
-->
<Name>DataSetS2</Name>
<Credential domain="ZZ">
<!-- This is a pre-defined credential-->
<Identity>GLOBAL</Identity>
</Credential>
<Action>ImportClassificationScheme</Action>
<URIInfo scheme="local">
<Relative>MQ_COMMON_DIR</Relative>
<!-- This directory is created outOfBox -->
<URI>velosel/GPC</URI>
</URIInfo>
<Incremental>Yes</Incremental>
<DataSource>
<RevisionID>
<!-- This a pre-defined data source in Velosel enterprise -->
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<BaseName>GPC</BaseName>
</RevisionID>
</DataSource>
<ClassificationScheme>
<RevisionID>
<!-- This a pre-defined classification scheme -->
<BaseName>GPC</BaseName>
</RevisionID>
</ClassificationScheme>
</DataSet>

2. Ensure that the following subdirectories exist under the $MQ_COMMON_
DIR/velosel/GPC/ directory.

incoming
rejected
done

3. Place the data file (.csv) in the $MQ_COMMON_DIR/velosel/GPC/incoming directory.
The .csv file is used to upload when the FileWatcher polling interval time is over. All
the rows from the .csv file are uploaded into the GPC data source. If the upload is
successful, the .csv file is copied into the done directory.

Configuring Support for GPC Code

Procedure
1. You can add GPC Dropdowns for Editing Records in a Repository.

2. For dependent drop-downs, add the following section to your catalog validation
rulebase:

<declare>
<var>GPC_classification</var>

<link type="datasource">
<literal>GPC</literal>

</link>
</declare>
<constraint>

<name>GPC CODE</name>
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<description>GPC CODE dropdown</description>
<usefor>

<var>GPC_SEGMENT_CODE</var>
</usefor>
<action>

<select novalue="option">
<table source="classification">
<literal>GPC_classification/SEGMENT_CODE</literal>
<literal>GPC_classification/SEGMENT_DESC</literal>
</table>
</select>

</action>
</constraint>
<constraint>

<name>FAMILY CODE</name>
<description>GPC Hierarchy Level 2 dropdown</description>
<usefor>

<var>GPC_FAMILY_CODE</var>
</usefor>
<condition>

<defined>
<var>GPC_SEGMENT_CODE</var>

</defined>
</condition>
<action>

<select novalue="default">
<table source="datasource">

<literal>GPC</literal>
<literal>FAMILY_CODE</literal>
<literal>FAMILY_DESC</literal>
<where>

<sql>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string">?</const>
</eq>
</sql>
<var>GPC_SEGMENT_CODE</var>

</where>
</table>

</select>
</action>

</constraint>
<constraint>
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<name>CLASS CODE</name>
<description>GPC Hierarchy Level 3 dropdown</description>
<usefor>

<var>GPC_CLASS_CODE</var>
</usefor>
<condition>

<defined>
<var>GPC_FAMILY_CODE</var>

</defined>
</condition>
<action>

<select novalue="default">
<table source="datasource">

<literal>GPC</literal>
<literal>CLASS_CODE</literal>
<literal>CLASS_DESC</literal>
<where>

<sql>
<and>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>FAMILY_CODE</literal>
<const type="string">?</const>

</eq>
</and>

</sql>
<var>GPC_SEGMENT_CODE</var>
<var>GPC_FAMILY_CODE</var>

</where>
</table>

</select>
</action>

</constraint>
<constraint>

<name>BRICK CODE</name>
<description>GPC Hierarchy Level 4</description>
<usefor>

<var>ADDITIONAL_CLASS_CAT_CODE</var>
</usefor>
<condition>

<defined>



ibi™ MDM Add-on for Global Data Synchronization User Guide

144 | Setting up GPC Classification Scheme Data Load

<var>GPC_CLASS_CODE</var>
</defined>

</condition>
<action>

<select novalue="default">
<table source="datasource">

<literal>GPC</literal>
<literal>BRICK_CODE</literal>
<literal>BRICK_DESC</literal>
<where>

<sql>
<and>
<eq>
<literal>SEGMENT_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>FAMILY_CODE</literal>
<const type="string">?</const>
</eq>
<eq>
<literal>CLASS_CODE</literal>
<const type="string">?</const>
</eq>
</and>
</sql>
<var>GPC_SEGMENT_CODE</var>
<var>GPC_FAMILY_CODE</var>
<var>GPC_CLASS_CODE</var>

</where>
</table>

</select>
</action>

</constraint>
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Configure TIBCO BusinessConnect and
TIBCO BusinessWorks
You can configure TIBCO BusinessConnect for sending documents to and receiving
documents from different data pools.

Details for configuring only TIBCO BusinessConnect to work with the application are
provided. Refer to the appropriate documentation if you want to use any other AS2
Gateway.

TIBCO BusinessConnect supports JMS, however, the latest version of TIBCO BusinessWorks
plug-in for BusinessConnect is still required.

Prerequisites for configuring TIBCO BusinessConnect
l The latest version of TIBCO BusinessConnect must be installed on the system.   See

TIBCO Business Connect documentation for details.

l A database must be installed. BusinessConnect supports Oracle, DB2, MySQL, and
SQL Server.

l TRA, Business Works, TIBCO Administrator, and TIBCO EMS must be installed on the
system.

l UserID and password to access the TIBCO BusinessConnect Admin console.

l Port 4080 or any other port on which TIBCO BusinessConnect is listening needs to be
opened.

Setting up TIBCO Administrator

Procedure
1. Install TIBCO Administrator in console mode and read the installation guide.

2. For Linux/UNIX setup, create Domain using the domain utility TIBCO_TRA_
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HOME/bin/domainutility.

l Set defaults settings, give domain names as: <<DOMAIN_NAME>>/, choose UTF-8
for character set, default ports -> http port=9090, AJP 1.3 port =8009, shutdown
port =8005, username=admin, password=admin

l If UTF-8 does not work, change the characters to another character set

l Change the owner to vsadmin and give all the rights to the tibco folder as -

sudo chown -R vsadmin:vsadmin /home/tibco/
sudo chmod -R 777 /home/tibco

3. On Windows, you can create a new domain using Programs - > TIBCO - > TIBCO
Runtime Agent & Adapter SDK <version> - > Domain Utility.

4. After successfully configuring TIBCO Administrator, start TIBCO Administrator by
executing the following on Linux/UNIX platform: <<TIBCO_
HOME>>/administrator/domain/<<DOMAIN_NAME>>/bin/tibcoadmin_<<DOMAIN_
NAME>>/&

5. Start TIBCO Hawk Agent by executing the following on Linux/UNIX platform:
<<TIBCO_HOME>>/tra/domain/<<DOMAIN_NAME>>/hawkagent_<<DOMAIN_NAME>>/&

6. For Windows installations, start TIBCO Hawk Agent as an NT service.

7. On Windows, set up TIBCO Administrator as an NT service.

8. Access the Administrator URL as:
http://<machinename>:9090/administrator/servlet/tibco_administrator

Setting up BusinessConnect
You can configure BusinessConnect by:

l Configuring BusinessConnect (new configuration)

l Importing an existing setup from another installation and customizing the imported
BusinessConnect configuration

The following criteria should be met before configuring BusinessConnect:

Procedure
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1. Database and Database user. A Database (which can be used by the
BusinessConnect setup) should be configured.

2. TIBCO EMS should be installed and started as an NT service on Windows; on Linux
it should be started on root.

3. Install Unlimited Strength JCE Policy Files To use BusinessConnect security
features, download and install JavaTM Cryptography Extension (JCE) Unlimited
Strength Jurisdiction Policy Files 1.5.0. To download and install the policy files,
follow these steps:

l Download the required files for   Windows, Sun Solaris, HP-UX, Linux,
  and IBM AIX.

l Unzip jce_policy-1_5_0.zip

l Copy US_export_policy.jar and local_policy.jar to TIBCO_
home\jre\1.5.0\lib\security

4. TIBCO Administrator and TIBCO Hawk should be started.

Configuring New BusinessConnect

Procedure
1. Start TIBCO Administrator

http://<machinename>:9090/administrator/servlet/tibco_administrator Login
as admin/admin.

2. Check if the BusinessConnect link appears in left side panel. If not, click Application
management - > All service instance - > machine name - > Plug-Ins - > Add -
and browse to the bcwebadmin.war file of BusinessConnect.   The .war file can be
found on:  <<TIBCO_HOME>>/bc/<version>/admin-plugins/ bcwebadmin.war
  Adding the .war file takes some time.

3. In the left side panel, BusinessConnect is available. Click BusinessConnect - >
Manage Installation.

4. Provide database details for installation and test connection for Oracle. Sample
database details:  JDBC Driver: tibcosoftwareinc.jdbc.oracle.OracleDriver   JDBC
URL: jdbc:tibcosoftwareinc:oracle://<oracleservername>:1521;SID=<<DATABASE_
NAME>>
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Creating Participants

Procedure
1. Creating participant of type Partner

a. Click BusinessConnect - > Participants

b. Select type of participant as Partner and create and provide a name to the
participant.

c. Provide all relevant details, click the Active check box to activate the
participant.
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d. Click the Credentials tab.

e. Click the New Certificate tab. Provide the alias name and upload the
certificate provided by the Trading partner (Data pool in case of MDM) followed
by Save.

f. Click the Protocols -Enable tab.

g. Select the EZComm protocol check box and click OK.

h. Click the newly enabled protocol EZcomm as in the following page.
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i. Click the Add New link to create a new AS2 ID.

j. Click the Add New tab to create a new AS2 ID.

k. Create new AS2 ID.

l. Select the newly created AS2 ID and click OK.

m. Click Transports -Add tab.
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n. Add details to Transport; select the Transport Type as AS2_HTTP, click OK.

o. Provide details for the newly created Transport.

p. Change the URL as per the trading partner specification.
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q. Keep the default proxy settings.

r. Click Save to save the participant.

2. Creating participant of type Host

a. Click BusinessConnect - > Participant.

b. Select the type of participant as Host and create and provide a name to the
participant.

c. Click the Active check box to activate the participant.
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d. Click the Credentials tab - New Private Key.

e. Provide the alias of the key, upload the private key (public key of which has
sent to Partner) and click Save.

f. Click the Protocols tab and enable EZcomm protocol as enabled earlier to
create Partner Participant.

g. Create a new AS2 ID, clicking on the newly enabled protocol EZcomm - > AS2
Identifier - > Add new link. In AS2 Identity, provide GLN on data pool.
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h. Click Save to save the participant.

Creating New Operations

Procedure
1. Click Business Connect - > Operation Editor.

2. Click the Edit button in the right pane for Protocol EZComm.

3. Click the radio button for EZComm protocol and then click the New > Category
button.
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4. Save the new category.

5. Click the new version button to create a new version for the new category. Provide
details and Save the version.

6. Click the New Operation button to create a new operation for this version.

7. Select the operation type as Asynchronous Request-Response and click OK.

8. On the next page, enter a name for the new operation.

9. Click the Request Action tab and select the Require Digital Signature and Require
Content Encryption check boxes.
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10. Click the Response Action tab and select the check boxes as previously mentioned.

11. Click the Save button to save the newly created operation.

12. Create this operation once for all participants.

Configuring System Settings

Procedure
1. Click the BusinessConnect - > System settings menu in the left panel.

2. Click JDBC Configuration in the right pane.
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3. Click JDBC Configuration to create new JDBC connection details for
BusinessConnect.

  Sample database details are as follows:  JDBC Driver Class:
tibcosoftwareinc.jdbc.oracle.OracleDriver  JDBC URL:
jdbc:tibcosoftwareinc:oracle://localhost:1521;SID=bcdb  Database User: bcuser
  Password: bcuser

4. Click Test Connection, if the connection is successful, click Save.

5. Select the newly created BusinessConnect connection in Audit Logs, Non Repudiation
Logs, Runtime Data Store, and click Done.

Defining Business Agreement

Procedure
1. Click BusinessConnect- > Business Agreement in the left panel.
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2. Click the New tab to create a new agreement.

3. Select the Host party and Partner party radio buttons for which you want to make
an agreement as shown in the following page and click OK.

4. Click the newly created Agreement.

5. Click the Valid check box on the next page and provide dates for start and end of the
agreement.

6. Click the Add Protocol Binding tab, to add new protocol binding. Select EZComm
from available protocols.

7. Click the EZComm protocol link and provide details.

8. Click the Document Security tab and select values.
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Here the values should be defined as follows:  Signing Key: Name of the TIBCO’s
private certificate.  Digest Algorithm: MD5  Encryption Certificate: Name of Trading
Partner Certificate  Encryption Algorithm: Encryption algorithm used by Trading
Partner  Verification Certificate: Name of Trading Partner Certificate  Decryption
Key: Name of the TIBCO’s private certificate

9. Click the Transports tab and select values.

Deploying the BusinessConnect configuration
(Single Server Mode)

Procedure
1. Deploy the configuration, click Administrator - > Business Connect - > System

Settings - > Deployment Configuration -click Create deployment Configuration.
The Business Connect link in Application Management is displayed.

2. Select a machine to deploy the Business Connect installation.   Click Application
Management - > Business Connect - > Configuration - > Single Server.par.
Select the machine name. If you do not see the machine name, it may be due to the
hawk agent.
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3. Select Application Management > BusinessConnect > Configuration >
BusinessConnect > Configuration and click Save.

4. Click Application Management - > BusinessConnect - > Configuration - >
Business Connect - > HTTP

5. Ensure the port is enabled and a proper value is provided.

6. Click Application Management - > BusinessConnect - > Configuration - >
BusinessConnect.

7. Click the Private Process Configuration tab and select the JMS radio button.

8. Click the JMS link and provide the JMS details. After completing all the details click
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Test connection to test the JMS connection. Save the details, if the test connection
is successful.   Sample details are as follows:  JNDI Context Factory:
com.tibco.tibjms.naming.TibjmsInitialContextFactory  JNDI Context URL:
tcp://localhost:7222  Topic Connection Factory: TopicConnectionFactory  Queue
Connection Factory: QueueConnectionFactory

9. Click Application Management - > BusinessConnect - > Configuration - >
Business Connect - > Deploy.

10. Click the Deploy Tab. Ensure the Start successfully deployed services check box is
selected.

11. Check the status of BusinessConnect availability. Click the Application Management
- > BusinessConnect - > Service Instance. The BusinessConnect instance status
displays as either stand by or running.
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12. If after the deployment, the BusinessConnect instance is not started, click
Application Management - > BusinessConnect - > Service Instance - >
BusinessConnect > Instance check box and click Start.

13. If all the actions are successful, the BusinessConnect instance should be in running
state. If the BusinessConnect instance cannot be started successfully, check the
TIBCO Administrator logs (<<TIBCO_HOME>>administrator\domain\<<DOMAIN_
NAME>>\logs\audit.txt) to find the cause.

Setting up Business Works
Prerequisites

l Before you start a BW project, create a directory as follows:   <<TIBCO_
HOME>>\fsjndi\designerExtendedJars

l Add the following JAR to this location: fscontext.jarjndi.jarproviderutil.jar

l Edit the designer.tra file located in <<TIBCO_HOME>>\designer\<version>\bin.

l Add the following entry to this file:  tibco.class.path.extended %CUSTOM_CP_
EXT%%PSP%%STD_CP_EXT%:<<TIBCO_HOME>>/fsjndi/designerExtendedJars

Procedure
1. Start TIBCO Designer.

2. Click New empty project.
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3. Specify the project directory and encoding.

4. Click Project -Import Full Project.

5. Import vcrepo.dat from the existing BW project directory (directory of the same
name as your existing BW configuration).

6. Alternately, if you don’t want to import the existing project, copy the existing BW
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project directory with another name. This is similar to importing the existing BW
project.

7. Edit the project as imported and copied above.

8. Change the following Global variables per the project requirement:

l bindingFile: Provide the directory location where you want to place your binding
file for this project.

l receiveFile: Provide the directory location where you want the received
messages to be saved.

l hostName: Provide the name of the participant which you configured in BC as
Participant of type Host.

l tpName: Provide the name of the participant which you configured in BC as
Participant of type Partner.

The Sample values are as follows:

9. Click Project Tab -Shared Connection.

10. If you already have a BusinessConnect connection configured, update the
connection.

11. Click the ‘Update from Configuration stores’ button.
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12. Select the Select operations check box; click OK on the next page.

13. Click the Import selected Business Protocol button.

14. Click the BusinessConnect Server Access tab.

15. Click Update from Configuration Store followed by the Import Selected Business
Protocol button.
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16. Click the JMS tab of the previous page.

17. Click Update from Configuration Store followed by the Import Selected Business
Protocol button.

18. If you have created a new BusinessConnect connection, ensure the property ‘Server
Details’ of all the activities point to a valid BC connection. A sample activity ‘Send
Request to TP’ of process ‘Send to TP Process’ is as follows:

19. Start the test engine by clicking the Tester tab on the left followed by a green start
signal.

20. Click Load selected.

21. After a successful start, all processes should be visible.
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Testing the MDM-BusinessWorks-
BusinessConnect Connectivity

Procedure
1. Have a ready-to-publish catalog in MDM.

2. In TIBCO Designer, ensure the BW tester is running, check for
Processes\Outbound\Send To TP Process, and all setup done.

3. The Binding file accessed by the BW setup should have the IP of the machine from
where testing has to be done.

4. The BC engine should be running and all setups should be done. Open TIBCO
Administrator.

5. Publish the product from MDM.

6. Check BW for Processes\Outbound\Send To TP Process, whether the message
received, as the activities flow shows green.

7. Check TIBCO Administrator for BusinessConnect, in Log Viewer, for a Audit Logs, for
selected time range, whether the message reached and whether the message went
out to the trading partner.

8. Check for acknowledgment from the datapool.

9. Check for response in BusinessConnect, BusinessWorks and MDM eventLog.
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10. TIBCO BusinessConnect EZComm Protocol does not record advisory messages, such
as the Responder Acknowledgment, in the audit log.
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GDSN Predefined Components - An
Overview
The out-of-the-box GDSN components are provided in the $MQ_
HOME/plugins/gdsn/version/common/standard folder. You can see these components if
you have the GDSN plug-in installed. The available components are maps, rulebases,
workflows, and templates.

Note: Do not modify the GDSN components supplied in this directory. If a
modification is required, maintain the modified file in an enterprise-specific
directory.

GDSN-Specific Rulebases
This section introduces you to rulebases specific to GDSN provided in the $MQ_
HOME/plugins/gdsn/version/common/standard/rulebase folder.

File Description

_1sync_catalogvalidation.xml This rulebase declares validation rules for out-of-the-box
catalog synchronization for 1Sync datapool.

_1sync_mastercatalog_
catalogvalidation.xml

This rulebase declares validation rules for the master
catalog used in synchronization having 1SYNC catalog
output map.

rbapprover.xml This is an empty rulebase which is used in the workflow
wfin26prodnotifretailerv4.xml to flag any errors or
warnings in the incoming message data. This rulebase
should be customized as per your business process needs.

rbconnectorprotocolderivation_gdsn.xml This rulebase decides the protocol to be used by the

GDSN-Specific Rulebases
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File Description

message handler for outgoing messages or the response
handler for incoming messages.

rbconnectorrolederivation.xml This rulebase decides the protocol to be used by the
message handler for outgoing messages or the response
handler for incoming messages.

rbduplicate.xml This rulebase provides a sample duplicate check constraint
for incoming messages. The sample rulebase is used to
implement a duplicate check for GDSN incoming messages.

rbeditor.xml This is an empty rulebase which is used in workflow
wfin26prodnotifretailerv4.xml and other incoming
message processing workflows to flag any errors or
warnings in the incoming message data. This rulebase
should be customized as per your business process needs.

rbformatattributes_gdsn.xml Format specific attributes to be used for a marketplace.

rbgdsnrelationship.xml This rulebase is used to identify the relationship to be used
in the GDSN edition.

rbGPCClassificationscheme.xml This rulebase drives the classification codes for the GPC
predefined classification scheme.

rbresponsehandlerprotocolderivation_
gdsn.xml

This rulebase is used to identify the protocol used for
message processing.

rbretailerval.xml This is a sample retailer validation rulebase.

rbsendmessage_gdsn.xml The generic page is available from the Product View page,
where there is an actions link for SendMessage based on
the user privileges (Role). The UI that opens on clicking this
link is completely customizable based on the underlined
rulebase rbsendMessage.xml. Currently, it is used to send
an RFCIN message and generate a fact sheet.

The following customizations are possible:

l Customize the product attributes that can be
displayed.

l Customize actions that can be performed.
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File Description

l Customize the MarketPlace and TradingPartner
Credentials.

l Customize the user defined attributes.

rbsyncstatusupdatederivation.xml This sample rulebase is used to customize the manual
synchronization status update action.

rbtolerance.xml Permissible values for attributes are defined in this
rulebase.

rbtransorasupplier.xml This rulebase identifies different sync operations for the
1SYNC datapool.

rbUDEXClassificationscheme.xml This rulebase derives the classification codes for the UDEX
predefined classification scheme.

rbworkitemdescription_gdsn.xml This rulebase derives out-of-the-box workitem descriptions
for the GDSN edition.

rbcim2cimsupplier.xml This rulebase identifies the operation state machine for CIM
to CIM supply side.

GDSN-Specific Forms
This section introduces you to forms specific to GDSN provided in the $MQ_
HOME/plugins/gdsn/version/common/standard/forms folder.

File Description

fmretailer.xml Used to populate retailer information on retailer side

GDSN-Specific Forms

GDSN-Specific Workflows
This section introduces you to workflows specific to GDSN provided in the $MQ_
HOME/plugins/gdsn/version/common/standard/workflow folder
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File Description

wfin26RFCINv2.xml The workflow to receive and process publication request (RFCIN)
for suppliers.

wfin26catsynchv7_gdsn.xml The workflow to initiate synchronization with datapool or custom
channel.

wfin26cim2cimsyncV1.xml CIM to CIM synchronization workflow.

wfin26proddatanotifbasicv2.xml The incoming record notification workflow for, primarily, data
add/change messages. Recommended for GDSN retailers and
similar usage where the received data needs to be processed and
saved.

wfin26prodnotifbasicv3.xml The incoming record notification workflow, primarily, for data
publication messages. It is a variation of
wfin26proddatanotifbasicv2.

wfin26prodnotifprocessv2.xml The workflow to process the incoming record message and save
data.

wfin26prodnotifretailerv4.xml The workflow to process the incoming record message and save
data. It is a variation of wfin26prodnotifprocessv2 targeted
towards datapools and integration hubs.

wfin26prodnotifv2.xml The workflow to receive a notification of a response for a previous
synchronization request sent. The notification is issued by CIM
when a response is received and processed.

wfin26catactionRFCINv2.xml The workflow to implement initiation of publication request
(RFCIN) for retailers.

wfout1sync62cic26v1.xml The workflow to translate the incoming 1Sync CIC message to an
mlXML format.

wfoutveloselcin26v2.xml The workflow to translate the incoming CIM2CIM message to an
mlXML format.

wfout1sync65cin26v1.xml The workflow to translate the incoming 1Sync CIN message to an
mlXML format.

GDSN-Specific Workflows
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GDSN-Specific Maps
This section introduces you to translation maps specific to GDSN provided in the $MQ_
HOME/plugins/gdsn/version/common/standard/maps folder.

File Description

mpfrom1sync62cicwlto26v1.xsl This XSLT translates an incoming CIC message (1SYNC
Item Authorization Response) to the mlXML format.

mpfromcatact26to1sync65v1.xsl This XSLT translates an outgoing mlXML message to
the 1Sync Catalog Request message format (1SYNC
Item Maintenance message).

mpfromcatact26tononebxml70v1.xsl This sample map file generates a non-ebxml outbound
message.

mpfromcatact26toveloselcinv1.xsl This file translates the outgoing mlXML messages to a
message format used in CIM-to-CIM synchronization.

mpfromcatact26toveloselcinv1_all_
Attributes.xsl

This file translates the outgoing mlXML messages to
the message format used in CIM-to-CIM
synchronization. It maps all the catalog attributes
rather than filtering out EAN.UCC format specific
attributes.

mpfromveloselcintoveloselcinrv1.xsl This file is used in CIM-to-CIM synchronization to
generate a response for an incoming message.

mpfromveloseltomlxml26v1.xsl This file translates an incoming message to the mlXML
format during CIM-to-CIM synchronization.

GDSN-Specific Maps
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Error Messages
Errors are classified depending on the category type of error and a description is provided
for each error code. This section lists the GDSN-specific error messages.

Rulebase Errors

MDM
Error
Code

Error Description

RB-1110 Synchronization profile $Catalog$ is being synchronized with retailer $TradingPartner$.
Approval required. (<Parameter name='RECORD_COUNT'/> records.)

RB-1111 Synchronization profile $Catalog$ is validated for synchronization with retailer
$TradingPartner$. Review required. (<Parameter name='RECORD_COUNT'/> records.)

RB-1112 Synchronization profile $Catalog$ is being synchronized with trading partner
$TradingPartner$. Approval required. (<Parameter name='RECORD_COUNT'/> records.)

RB-1113 Synchronization profile $Catalog$ is validated for synchronization with trading partner
$TradingPartner$. Review required. (<Parameter name='RECORD_COUNT'/> records.)

RB-1115 A message was received for which the trading partner identified by <Parameter
name='CUSTOM_DOMAIN'/> <Parameter name='CUSTOM_GLN'/> was not recognized.
Actions required.

Rulebase Errors

Miscellaneous Errors
This section contains GDSN-specific errors in the Rulebase (RUL), General (GEN), and
Service (SVC) categories.
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MDM Error
Code

Error Description

RUL-4620 Action Type must be either IRulebase.ELEM_ACTION_TYPE_THEN or
IRulebase.ELEm_ACTION_TYPE_ELSE.

GEN-7073 Application shutting down. Internal error.

GEN-7218 Delete datapool <Parameter name='NAME'>?

GEN-7229 Synchronization format is default format for trading partner.

SVC-11013 Unsupported record state <Parameter name='RECORD_STATE'> specified for entity
object.

SVC-11046 Cannot initiate workflow.

Miscellaneous Errors

Administration Errors

MDM
Error
Code

Error Description

ADM-3005 Invalid value <Parameter name='VALUE'> specified. Cannot generate Check digit.

ADM-3033 No trading partners found.

ADM-3315 Not subscribed to datapool.

ADM-3326 <Parameter name='TYPE'> of company cannot have trading partners.

ADM-3328 Global trading partner name <Parameter name='NAME'> already used within same
enterprise. Specify unique name.

ADM-3329 Private trading partner name <Parameter name='NAME'> already used within same
enterprise. Specify unique name.

Administration Errors
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MDM
Error
Code

Error Description

ADM-3330 Global trading partner name <Parameter name='NAME'> used in another enterprise.
Name should be unique across all enterprises.

ADM-3331 Private trading partner name <Parameter name='NAME'> used in another enterprise.
Provide a unique name.

ADM-3332 Trading partner name <Parameter name='NAME'> already used.

Catalog Errors

MDM
Error
Code

Error Description

CAT-
1068

No credentials for Trading partner <Parameter name='VALUE'> (<Parameter
name='VARIABLE'>) defined on <Parameter name='VARIABLE2'>.

CAT-
1069

Datapool or trading partner credentials not provided. Correct and re-try.

CAT-
1201

Organization currently not subscribed to any datapools. Ensure subscription to at least
one datapool before attempting to synchronize.

CAT-
1202

Synchronization profile associated with datapool <Parameter name='NAME'> not
subscribed by your organization. Subscribe to the specified datapool first.

CAT-
1203

Already subscribed to this datapool.

CAT-
1247

Associate GPC/UDEX classification scheme with repository for synchronization with
predefined datapools.

CAT-
1271

Invalid synchronization profile; Trading partner <Parameter name='NAME'> deleted.

Catalog Errors
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MDM
Error
Code

Error Description

CAT-
1279

Synchronization format <Parameter name='VALUE2'> not supported by Datapool
<Parameter name='VALUE'>.

CAT-
1280

Repository does not support output formats of datapool <Parameter name='VALUE'>.

CAT-
1293

Warning: <Parameter name='VALUE'> with relationships.

CAT-
1304

Cannot load Synchronization profile '<Parameter name='NAME'>'.

CAT-
1305

Synchronization profile <Parameter name='VALUE'>.

CAT-
1306

Synchronization profile <Parameter name='VALUE'> (<Parameter name='VALUE2'> items).

CAT-
1307

Synchronization profile <Parameter name='VALUE'> (<Parameter name='VALUE2'> items)
synchronization with <Parameter name='VALUE3'>.

CAT-
1308

Synchronization profile <Parameter name='VALUE'> (<Parameter name='VALUE2'> items)
synchronization on <Parameter name='VALUE3'>.

CAT-
1309

Synchronization profile <Parameter name='VALUE'> synchronization with <Parameter
name='VALUE3'>.

CAT-
1310

Synchronization profile <Parameter name='VALUE'> synchronization on <Parameter
name='VALUE3'>.

CAT-
1311

Preview of synchronization profile <Parameter name='VALUE'> (<Parameter
name='VALUE2'> items).

CAT-
1312

Validation of synchronization profile <Parameter name='VALUE'> (<Parameter
name='VALUE2'> items).

CAT-
1313

Item <Parameter name='VALUE'> added to repository <Parameter name='VALUE2'>.
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MDM
Error
Code

Error Description

CAT-
1314

Item <Parameter name='VALUE'> changed in repository <Parameter name='VALUE2'>.

CAT-
1315

Item <Parameter name='VALUE'> deleted in repository <Parameter name='VALUE2'>.

CAT-
1316

Conflicts in item <Parameter name='VALUE'> in repository <Parameter name='VALUE2'>.
Action required.

CAT-
1317

Synchronization profile <Parameter name='VALUE'> synchronization with <Parameter
name='VALUE3'> on <Parameter name='VALUE4'>.

CAT-
1318

Synchronization profile <Parameter name='VALUE'> (<Parameter name='VALUE2'> items)
synchronization with <Parameter name='VALUE3'> on <Parameter name='VALUE4'>.

CAT-
1319

On <Parameter name='VALUE3'>.

CAT-
1320

Item <Parameter name='VALUE'> added <Parameter name='VALUE3'>.

CAT-
1321

Item <Parameter name='VALUE'> changed <Parameter name='VALUE3'>.

CAT-
1322

Item <Parameter name='VALUE'> deleted <Parameter name='VALUE3'>.

CAT-
1323

Item <Parameter name='VALUE'> corrected <Parameter name='VALUE3'>.

CAT-
1324

Item <Parameter name='VALUE'> pending <Parameter name='VALUE3'>.

CAT-
1325

Item <Parameter name='VALUE'> pending with <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1326

Item <Parameter name='VALUE'> pre-authorized <Parameter name='VALUE3'>.
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MDM
Error
Code
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CAT-
1327

Item <Parameter name='VALUE'> pre-authorized by <Parameter name='VALUE2'>
<Parameter name='VALUE3'>.

CAT-
1328

Item <Parameter name='VALUE'> authorized <Parameter name='VALUE3'>.

CAT-
1329

Item <Parameter name='VALUE'> authorized by <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1330

Item <Parameter name='VALUE'> deleted <Parameter name='VALUE3'>.

CAT-
1331

Item <Parameter name='VALUE'> deleted by <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1332

Item <Parameter name='VALUE'> rejected <Parameter name='VALUE3'>.

CAT-
1333

Item <Parameter name='VALUE'> rejected by <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1334

Item <Parameter name='VALUE'> publication requested <Parameter name='VALUE3'>.

CAT-
1335

Item <Parameter name='VALUE'> publication requested by <Parameter name='VALUE2'>
<Parameter name='VALUE3'>.

CAT-
1336

Item <Parameter name='VALUE'> load requested <Parameter name='VALUE3'>.

CAT-
1337

Item <Parameter name='VALUE'> load requested to <Parameter name='VALUE2'>
<Parameter name='VALUE3'>.

CAT-
1338

Item <Parameter name='VALUE'> published <Parameter name='VALUE3'>.

CAT-
1339

Item <Parameter name='VALUE'> published to <Parameter name='VALUE2'>.
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Error
Code
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CAT-
1340

Item <Parameter name='VALUE'> changed <Parameter name='VALUE3'>.

CAT-
1341

Item <Parameter name='VALUE'> changed to <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1342

Item <Parameter name='VALUE'> de-listed <Parameter name='VALUE3'>.

CAT-
1343

Item <Parameter name='VALUE'> de-listed from <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1344

Item <Parameter name='VALUE'> withdrawn <Parameter name='VALUE3'>.

CAT-
1345

Item <Parameter name='VALUE'> withdrawn from <Parameter name='VALUE2'>
<Parameter name='VALUE3'>.

CAT-
1346

Item <Parameter name='VALUE'> loaded <Parameter name='VALUE3'>.

CAT-
1347

Item <Parameter name='VALUE'> loaded to <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1348

Item <Parameter name='VALUE'> corrected <Parameter name='VALUE3'>.

CAT-
1349

Item <Parameter name='VALUE'> corrected to <Parameter name='VALUE2'> <Parameter
name='VALUE3'>.

CAT-
1350

Item <Parameter name='VALUE'> not received <Parameter name='VALUE3'>.

CAT-
1351

Item <Parameter name='VALUE'> not received by <Parameter name='VALUE2'>
<Parameter name='VALUE3'>.
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GDSN Samples
The GDSN samples are located in the $MQ_
HOME/plugins/gdsn/version/common/standard/samples folder.
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WorldSync Samples
The GDSN-specific 1WorldSync samples are:

l mlxml indoc (supplier)

l sync messages (retailer)

l sync messages (supplier)

mlxml indoc (supplier)
These samples are located in the $MQ_
HOME/plugins/gdsn/version/common/standard/samples/1Sync/mlxml indoc/Supplier
folder:

Add_Cancel.xmlAdd_Correct.xmlAdd_Discontinue.xmlAdd_New.xmlAdd-
Reinstate.xmlLink.xmlLink-UnLink.xmlPublish_New.xmlPublish-Reload-copy.xmlPublish-
Reload-original.xml

These internal MDM messages are converted to 1WorldSync datapool format.

These are MDM specific internal formats for the corresponding sync
operation/suboperation selected in the synchronization profile/workitem or send
response/message pages.

The naming convention for the sample files is OPER_SUBOPER.xml, where OPER is the
operation selected in synchronization event, SUBOPER is the suboperation selected in
synchronization event. For details of operation and suboperation, see MDM Operations for
1WorldSync Messages (Supplier Operations).

sync messages (retailer)
These samples are located in the $MQ_
HOME/plugins/gdsn/version/common/standard/samples/1Sync/sync messages/Retailer
folder.
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File name Description

CICR.xml Catalog Item Confirmation Response (CICR) received from Datapool in response
to CIC messages.

CINR.xml This message is sent by CIM in response to CIN.

CIN-Hierarchy-
New.xml

This new or initial load message is received from Datapool when the supplier
publishes the hierarchy for the retailer.

CIN-Hierarchy-
Correction.xml

This correction message is received from Datapool when the supplier publishes
the hierarchy for the retailer.

CIN-singleRecord-
New.xml

This new or initial load message is received from Datapool when the supplier
publishes single record for the retailer.

CIC_RECEIVED.xml The CIC message with status as RECEIVED sent by retailer in receipt of CIN. By
default, this is sent by CIM or by the retailer on clicking the send response link
on the Record View page.

CIC_REJECTED.xml The CIC message with status as REJECTED sent by retailer in receipt of CIN.
This message is sent when a user takes action on authorization work item and
selects Reject Notification or by the retailer on clicking the send response link
on the Record View page.

CIC_REVIEW.xml The CIC message with status as REVIEW sent by retailer in receipt of CIN. This
message is sent when user takes action on authorization work item and selects
Review Notification or by the retailer on clicking the send response link on the
Record View page.

CIC_
SYNCHRONISED.xml

The CIC message with status as SYNCHRONISED sent by retailer in receipt of
CIN. This message is sent by the retailer on clicking the send response link on
the Record View page.

Item Cancel.xml When the supplier publishes the hierarchy for the retailer with CancelDate
populated, this correction message is received from Datapool.

Item Delete.xml This delete message is received from Datapool when the supplier publishes the
delete operation for the retailer.

Item
Discontinue.xml

When the supplier publishes the hierarchy for the retailer with DiscontinueDate
populated, this correction message is received from Datapool.

1WorldSync Samples: Sync Messages (Retailer)
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File name Description

RFCIN.xml The RFCIN message sent by the retailer with isReload set as true or false.

This message is sent on selecting the Send Message link on the Record View
page. The Include Rejected Record option should be selected or cleared.

RFCINR.xml Request For Catalog Item Notification Response (RFCINR) received from
Datapool in response to RFCIN messages.

sync messages (supplier)
These samples are located in the $MQ_
HOME/plugins/gdsn/version/common/standard/samples/1Sync/sync messages/Supplier
folder.

File name Description Operation Selected on Synchronization
Profile

Add_New.xml ITEM ADD message is
sent for the new
records added but not
synchronized to the
datapool.

Incremental

Yes

Deliver To

Datapool

Operation

Add

Add_Correct.xml ITEM CORRECTION
message having values
for the modified
records.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data Correction

Add_Discontinue.xml ITEM CORRECTION
message having
discontinueDate
populated for the
records, which have to
be discontinued.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data
Correction/

Discontinue

Add_Cancel.xml ITEM CORRECTION
message having
cancelDate populated

Incremental

Yes/No

Deliver To

Datapool

Operation

Data

1WorldSync Samples: Sync Messages (Supplier)
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File name Description Operation Selected on Synchronization
Profile

for the records, which
have to be canceled.

Correction/

Cancel

Add-Reinstate.xml ITEM CORRECTION
message not having
cancelDate or
discontinueDate for
the records that were
canceled or
discontinued.

Incremental

Yes/No

Deliver To

Datapool

Operation

Data
Correction/

Reinstate

Link.xml ITEM LINK ADD
message sent to
1WorldSync if a new
relationship for the
parent record or
change in relationship
of parent record is
detected.

Incremental

Yes/No

Deliver To

Datapool

Operation

Add/Data
Correction

Link-UnLink.xml ITEM LINK DELETE
message sent to
1WorldSync when a
relationship change of
parent record is
detected.

Incremental

Yes/No

Deliver To

Datapool

Operation

Add/ Data
Correction

Publish_New.xml PUBLICATION ADD
message of New type
sent to the retailer, for
example, Trading
Partner.

Incremental

Yes/No

Deliver To

Trading
Partner on
Datapool

Operation

Add/ Publish

Publish-Reload-
  original.xml

PUBLICATION ADD
message of New type,
sent to the retailer, for
example, Trading
Partner.

Incremental

Yes/No

Deliver To

Trading
Partner on
Datapool

Operation

For RELOAD-
  ORIGINAL-
Initial Load+
Include
Rejected
Records
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File name Description Operation Selected on Synchronization
Profile

Publish-Reload-
  copy.xml

PUBLICATION ADD
message of InitialLoad
type, sent to the
retailer, for example,
Trading Partner.

Incremental

Yes/No

Deliver To

Trading
Partner on
Datapool

Operation

For RELOAD-
  COPY: Initial
Load

CIC_REVIEW.xml Catalog Item
Confirmation message
of the Review type
received from
Datapool initiated by
retailer or Trading
Partner.

This is an incoming
message.

None None None

CIC_RECEIVED.xml Catalog Item
Confirmation message
of the Received type
received from
Datapool initiated by
retailer or Trading
Partner.

This is an incoming
message.

None None None

CIC_REJECTED.xml Catalog Item
Confirmation message
of the Rejected type
received from
Datapool initiated by
retailer or Trading
Partner.

This is an incoming
message.

None None None

CIC_
SYNCHRONISED.xml

Catalog Item
Confirmation message
of the Synchronised
type received from

None None None
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File name Description Operation Selected on Synchronization
Profile

Datapool initiated by
retailer or Trading
Partner.

This is an incoming
message.
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cim2cimmetadata
This section contains the details of GDSN-specific cim2cim metadata samples located in
the $MQ_HOME/plugins/gdsn/version/common/standard/samples/cim2cim metadata
folder.

File name Description

Bottler1-MetaData.jar Bottler1-specific repository and Business Process Rules are created.

Bottler2-MetaData.jar Bottler2-specific repository and Business Process Rules are created.

BrandOwner-MetaData.jar Brandowner-specific repository and Business Process Rules are
created.

VeloselMarketplace-
MetaData.jar

VeloselMarketplace-specific repository and Business Process Rules
are created.

cim2cim Metadata Samples
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TIBCO Documentation and Support Services

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than
any other documentation included with the product. To access the latest documentation,
visit https://docs.tibco.com.

Product-Specific Documentation

The following documentation for ibi™ MDM Add-on for Global Data Synchronization is
available at ibi™ MDM Add-on for Global Data Synchronization Product Documentation
page:

l ibi™ MDM Add-on for Global Data Synchronization Release Notes

l ibi™ MDM Add-on for Global Data Synchronization Installation

l ibi™ MDM Add-on for Global Data Synchronization User Guide

To access documentation for this product, go to the following location:

TIBCO_HOME/release_notes/TIB_cim-gdsn_4.0.0_docinfo.html

Here, TIBCO_HOME is the top-level directory in which TIBCO products are installed. On
Windows, the default TIBCO_HOME is C:\tibco. On UNIX systems, the default TIBCO_HOME
is /opt/tibco.

How to Contact TIBCO Support

You can contact TIBCO Support in the following ways:

l For an overview of TIBCO Support, visit http://www.tibco.com/services/support.

l For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support portal at
https://support.tibco.com.

https://docs.tibco.com/
https://docs.tibco.com/products/ibi-mdm-add-on-for-global-data-synchronization-4-0-0
http://www.tibco.com/services/support
https://support.tibco.com/
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l For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to
https://support.tibco.com. If you do not have a user name, you can request one by
clicking Register on the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
https://community.tibco.com.

https://support.tibco.com/
https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE
SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ibi, ibi logo, ActiveMatrix BusinessWorks, TIBCO
Administrator, BusinessConnect, TIBCO Designer, Enterprise Message Service, Hawk, and Maporama
are either registered trademarks or trademarks of Cloud Software Group, Inc. in the United States
and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
Corporation and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.

https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SOFTWARE GROUP, INC. MAY MAKE IMPROVEMENTS
AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT
ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of Cloud Software Group, Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 1999-2023. Cloud Software Group, Inc. All Rights Reserved.

https://www.tibco.com/patents
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